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About this Manual

Notations

The following notations may be used in this manual.

Microsoft Windows 7 64-bit Edition operating system — Windows 7 (64bit version)*
Microsoft Windows Vista ™ 64-bit Edition operating system — Windows Vista (64bit
version)*

Microsoft Windows Server 2008 R2 64-bit Edition operating system — Windows Server 2008
R2*

Microsoft Windows Server 2008 64-bit Edition operating system — Windows Server 2008
(64bit version)*

Microsoft Windows XP x64 Edition operating system — Windows XP (x64 version)*
Microsoft Windows Server ™ 2003 x64 Edition operating system — Windows Server 2003
(x64 version)*

Microsoft Windows 7 operating system — Windows 7*

Microsoft Windows Vista ™ operating system — Windows Vista*

Microsoft Windows Server 2008 operating system — Windows Server 2008*

Microsoft Windows XP operating system — Windows XP*

Microsoft Windows Server ™ 2003 operating system — Windows Server 2003*

Microsoft Windows 2000 operating system — Windows 2000

Generic name for Windows, Windows Vista, Windows Server 2008 R2, Windows Server
2008, Windows XP, Windows Server 2003, Windows 2000 — Windows

If there is no special description, 64 bit version is included in Windows 7, Windows Vista,
Windows Server 2008, Windows XP and Windows Server 2003.

MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2 = MacOS

MacOS X 10.3 and later - Mac OS X

Generic name for MacOS 9.0/9.0.4/9.1/9.2/9.2.1/9.2.2, and Mac OS X 10.3 or later —
Macintosh

Terms

(Notel) Cautions or restrictions that are required to operate this software correctly.

Be sure to read sections with this mark to ensure operations are performed correctly.

memo | INdicates information that is useful to know or refer to when using the software. You should

read sections with this mark.



Important

Trademark Information

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Microsoft, Windows, Windows Server, Windows Vista, Excel, and Active Directory are the
trademarks or registered trademarks of Microsoft Corporation in the United States and other
countries.

Macintosh and Mac OS are the trademarks or registered trademarks of Apple Computers Inc.
in the United States and other countries.

PageMaker is the trademark or registered trademark of Adobe Systems Incorporated in the
United States and other countries.

SD Memory Card is the trademark or registered trademark of SD Association.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.

About This Manual

1. Unauthorized copying of this manual in whole or in part is strictly forbidden.

2. The contents of this manual may be changed at any time without prior notice.

3. Every effort has been made to ensure that the information in this document is complete,
accurate and up-to-date. However, in the unlikely event you find a mistake or missing entry,
please contact your local vendor.

4. While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

Manual Copyright

Oki Data Corporation owns the entire copyright to this manual. Unauthorized reproduction,
transcription, and translation of this document are prohibited. You must obtain written
permission from Oki Data Corporation to reproduce, transcribe, or translate any sections of
this manual.

© 2012 Oki Data Corporation



License Agreement

Please read the following license agreement before using this software. This software includes
Print Job Accounting, Print Job Accounting Enterprise, Print Job Accounting Client, and all related
explanatory materials provided by Oki Data Corporation (hereinafter Oki Data). By using this
software, you are consenting to be bound by this agreement with Oki Data, and agree to the
conditions outlined herein.

. This software can only be used with the corresponding Oki Data printer.

The user is only permitted to install one copy of Print Job Accounting (or Print Job Accounting
Enterprise) on one computer. You are required to purchase additional software in order to use
this software on two or more computers.

Print Job Accounting Client can be installed an used on any number of computers.

. Ownership of all copyrights associated with this software and any copies therein belong to Oki
Data and any licenser who has been granted licensing rights by Oki Data. The customer is not
granted any rights to this software other than the rights described in this agreement. Other
than the installation described in article 1 above, the customer is not permitted to duplicate
this software in whole or in part, or to permit a third part to duplicate this software in whole
or in part. The customer agrees not to revise, modify, translate, reverse engineer, reverse
compile, or disassemble this software.

. The customer agrees not to rent, loan, lease, distribute, copy, or transfer this software in
any way. The customer also agrees not to forward, transfer, export or re-export this software
outside Japan, and not to use this software for any unlawful activities.

. If the customer violates any of the terms of this agreement, Oki Data can instruct the customer
to stop using the software and terminate the license agreement. In such a case in which the
license agreement is terminated, the customer shall cease use of the original software and all
copies, and destroy all copies of the software.

. Within a period of 90 (ninety) days from the purchase of this software, if a physical defect to
the recording media on which this software is stored prevent proper use of the software, Oki
Data will provide a replacement equivalent item. If the software does not operate correctly
for any other reason, Oki Data will provide a refund to the customer that is limited to the
equivalent cost paid for the software. However, Oki Data provides no warranty whatsoever
for any cases in which the software does not operate that are caused by accidents, improper
handling, or misuse of the software by the customer. Furthermore Oki Data provides no
warranty whatsoever against problems that arise due to interference from other software on
the customer's computer.

. The selection, use, and results of using this software are entirely the responsibility of the
customer.

. This software may be changed or improved with no prior warning. However, irrespective of
customer wishes, Oki Data is not obliged to provide any kind of maintenance service such as
bug fixes, modified contents, or revised editions of this software. Furthermore, Oki Data is not
obliged to provide the customer with bug information, details of modified contents, or other
such revision information of this software.

. Oki Data is not obliged to provide any kind of bug fixes or maintenance service for any
software manufactured by a different company that is provided with this software.
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1. Before Setup

1. Before Setup

This section explains the mechanisms and configuration of Print Job Accouting, and the
contents that need to be decided before setup.

What is Print Job Accouting?

Print Job Accouting sets detailed print restrictions on print jobs printed from computers
according to individual users and printers, and acquires and summarizes print job information
in a log.

Special Features of Print Job Accouting

Management of Print Restrictions
e Multiple users and printers can be put together into groups, and settings for allowing and disallowing
printing or color printing for each group can be configured.

e Settings for allowing or disallowing the printing or color printing of the login name, application name,
document name or host name can be configured.

e Upper limits for the number of prints can be set according to user, printer, user group and printer
group.

e Printing costs can be charged according to user and user group. Printing costs can be set according to
such factors as quantity and paper size. Also, different fees can be set for individual printers.

e Settings for allowing or disallowing printing or color printing can be configured for users or groups
registered in the Active Directory. (Only Enterprise edition)

e Printing costs can be charged according to users and groups in the Active Directory. (Only Enterprise
edition)
Log Acquisition and Summary

e Information included the printed date and time, user name, quantity and paper size can be acquired
and summarized in the log.

e The log can be output as a CSV file for use in commercially available spread sheet software.

e Information such as log information can also be saved in an SQL database and browsed from a web
browser.

A CSV file is a text file separated by commas, and is a file format that is commonly used for
converting data between spread sheets and database management software.

Support for both Windows and Macintosh operating environments

e Both Windows and Macintosh operating environments are supported as client environments.

-12 -



1. Before Setup

Print Job Accouting Mechanisms

@ When the user sends a print job, @ the job information is stored as a log on the printer's
built-in hard disk or flash memory, and the ® Print Job Accouting server software obtains
the log. The information obtained by the server software is deleted from the printer. @ The
log obtained in @ is saved to the SQL database. (Only Enterprise edition) ® User or group
information registered in the Active Directory is referenced. (Only Enterprise edition)

Client Computer Printer Printdob Accounting  SQL Database Active Directory
Server Server Server

- 13 -



1. Before Setup

Print Job Accouting Configuration

Print Job Accouting server software (Windows)

This is a management tool for the system administrator. Registration of printers and users, and print
limitation settings can be configured. Also, the log is obtained and saved from the printer at a set
schedule.

This is called server software.
Print Job Accounting Client Software (Windows)

Install onto the Windows client computer.

Set the setting method (job account mode) for setting the User Name and Job Account ID in the client
computer.

This is called Client Software.
Print Job Accounting Client Plugin (Mac OS)

This is automatically installed when the Mac OS PS printer driver is installed. A panel for setting the
UserName and JobAccountingID is added to the print dialog.

This is called a plugin.

Print Job Accounting Client Software (MacOS X)

This is installed in the Mac OS X client computer.

Set the Username and JobAccountingID on the client computer.
Only the Mac OS X PS printer driver is enabled.

This is called Client Software.

- 14 -



1. Before Setup

Print Job Accouting Installation Process

Setting up server software

Prepare Job Account ID, name and User Name

information.

¥

Installing the server software.
For details on how to set up the software,
see the "Installation Manual (tentative

name)".

¥

If required, configure software that is related to the
server software. (Only Enterprise edition)

¥

Configure the printer in the server software.

¥

Register the Job Account ID and name.

Setting up Client Software

For Windows For Mac OS For Mac OS X
Install the Client Configure the plugins. Install the Client
Software. Software.

¥

Select Job Accounting
Mode.

- 15 -
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1. Before Setup

Preparing User Information

In Print Job Accouting, set the user for the server software and Client Software/plugin.

Before setup, it is necessary to decide which users will use the printer.

(Note!) e Users can be added/deleted at a later date. For details, see "Job Account ID management"

(page 44).

e When using in combination with Active Directory, it is not necessary to decide which
users will use the printer. For details, see "Syncing with Active Directory user information"

(page 98). (Only Enterprise edition)

Information required for settings

In order to configure user settings, Job Account ID, name and User Name information is

required.

Read the explanation below carefully, and prepare the Job Account ID, name and User Name

information according to the objectives of the print restrictions and log.

Server software

Setting
information

Details

Registration range

Job Account ID

This number is used to recognize users
in Print Job Accouting. Assigned to each
user, settings such as print restrictions

and cost burden are set for each Job
Account ID on the server software.

1~999999999

Name

This name is applied to make the Job
Account ID easy to distinguish.

Up to 80 characters
(Names cannot include "")

Client Software/Plugi

n

Setting
information

Details

Registration range

Job Account ID

This number is used to recognize users
in Print Job Accouting.

When print restrictions or logs are
configured for each department, the
same ID is assigned to all users within
the department.

When printing is performed without
setting the Job Account ID, printing is
performed by an unregistered user and
0 remains as the Job Account ID in the
log.

1~999999999

- 16 -




1. Before Setup

Setting Details Registration range
information
Name This setting is for recognizing the actual Up to 80 characters

user who ordered the print job from

the client computer. This information is
stored in the "User" section of the log.
When printing is performed from a
Windows or Mac OS X computer that is
not configured with the Client Software,
the user is an unregistered user, Job
Account ID is 0, and the user name used
to log on to either Windows or Mac OS X
remains in the log as the User Name.
When printing is performed from a Mac
OS computer that is not configured with
the "Job Accounting" panel, the user is
an unregistered user, JobAccountingID
is 0, and UserName remains as a blank
space in the log.

(Names cannot include "")

(Note!) Depending on applications such as the Windows version of PageMaker, data that does not use
printer drivers may be created.
In this case, the user is an unregistered user, Job Account ID is 0, and User Name is remains
as a blank space in the log.

-17 -



1. Before Setup

Example of assigning the Job Account ID

The following usage methods are possible depending on how the settings and limitations are
configured and the logging method.

Example of Use

Server software settings

Client Software/Plugin
Settings

When you want to
permit printing for
only some users.

Set the Job Account ID
and name only to users
who are permitted to
print. Unregistered IDs are
prohibited from printing.

Set the Job Account IDs that are
permitted to print.

When you want
to permit color
printing for only
some users.

Set the Job Account ID and
name only to users who

are permitted to print in
color. Unregistered IDs are
prohibited from color printing.

Set the Job Account IDs that are
permitted to print.

When you want
to keep a record
of the printing
limitations and log
for each user.

Set a unique Job Account ID
and name for each user so
there are no duplications.

Set the User Name and Job
Account ID for each user so there
are no duplications.

When you want
to keep a record
of the printing
limitations and
log for each
department.

Set a Job Account ID and
name for each department.
When information is totaled
for [Job Account ID], the log
for each department can be
obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want

to place print
restrictions on each
department, but
log printing in each
person's name.

Set a Job Account ID and
name for each department.
When information is totaled for
[User Name], the log for each
user can be obtained.

Set the Job Account ID assigned
to the department, and set the
name of the user that is printing
as the User Name.

When you want

to apply print
limitations and
obtain logs for
each department,
yet also apply
limitations and
obtain logs for each
user.

Set a unique Job Account ID
and name for each user so
there are no duplications.
Divide users into user groups
according to department.

Set the User Name and Job
Account ID for each user so there
are no duplications.

- 18 -




1. Before Setup

Example of Use | Server software settings SUETE SETITE TS/ PUET

Settings
When you want The Job Account ID and name <For Windows and Mac OS X>
to just collect a do not need to be set. The Client Software does not
print log without When information is totaled for | need to be installed on the client
imposing print [User Name], the log for each computer. The login user name
restrictions. user can be obtained. used for Windows or Mac OS X
remains in the log as the User

Name.

<For Mac OS>

The JobAccountinglD is set as
desired, and the UserName is set
as the user name for printing.

If Print Job Accouting associates with Active Directory, Login name and Card ID registered on
Active Directory in advance can be used as the user information. (Only Enterprise edition)
Card ID is registered to assign to unused arbitrary attribute with Active Directory.

Setting information for Active .
) Details
Directory
Login name This name is used to login to Windows.
Card ID This ID is the meaning information which
can identify a card.

For detail on usable Card ID, refer to Card Secure Kit user manual.
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Memo
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2. Setting up the server software

2. Setting up the server software

This section explains how to set up the Print Job Accouting server software.

(Note!) The window and setting contents differ depending on the printer model.

Operating Environment

®\Windows 7 / Windows 7 (64bit version)

@ \Windows Vista / Windows Vista (64bit
version)

® Windows Server 2008 R2

® Windows Server 2008 / Windows Server
2008 (x64 version)

® \Windows XP / Windows XP (x64 version)

® Windows Server 2003 / Windows Server
2003 (x64 version)

® Windows 2000

(Note!) e The computer in which the server
software is installed needs to remain
switched on, or needs to be running at
the time at which the log is set to be
obtained from the printer.

e Approximately 3MB of hard disk space
is required to save 10,000 log entries
on the computer.

Installing the server
software

For details on how to install the server
software, see the "Installation Manual".
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Server software window configuration

@ [File] Menu
Commands for exiting the server software are displayed.

® [Printer] Menu
Commands for adding, deleting and managing printers that obtain logs are displayed.

® [Log] Menu
Logs and summaries are displayed, and commands for writing to files are also displayed.

Items in the [Printer] menu and [Log] menu can also be selected by right-clicking the mouse
on the printer or log to be operated, and selecting the command.

@ [Policy] Menu
Commands for setting the usage limitations are displayed.

® [Option] Menu
Commands for setting the options are displayed.

® [Help] Menu
You can view the Server ID, help and version information.

@ Selection window
Printers managed using Print Job Accouting and obtained logs are displayed in a tree format
according to printer and date.
The tree can be opened and closed using the same standard operations as Windows
Explorer. The tree is in the closed state directly after starting the server software, and needs
to be opened in order to select items.

Details window
Double-click the [Printer] that is at the origin of the tree in the selection window, and the
address, group it belongs to, log obtained/unobtained status, and date on which the last log
was obtained for printers managed by Print Job Accouting are displayed.
Double-click the log in the selection window to display the log.
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Starting the server software

(Note!) e The server software settings cannot
be configured without computer
administrator authority.

e When the simple user switching
function is used in Windows XP to
switch users, these settings can only
be configured in the user where the
server software was first started.

@ Check that the printer power is ON.

@® Sclect [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accouting] > [Print Job
Accouting].

When the [User Account Control] window
is displayed, click [Yes] or [No].
The server software starts.

® When the server software is started for
the first time, a window is displayed
notifying you of the Server ID. You must
write down the Server ID and store it
safely.

In Print Job Accouting, the log from one
printer cannot be obtained by multiple

servers. For this reason, in order to
distinguish which server is obtaining the
printer log, the Server ID is set in the
printer.

If a Print Job Accouting sever cannot be
used due to breakdown etc, obtaining
of the log needs to be changed to a
different server.

Setting up the server
software

Configuring Active Directory
settings (Only Enterprise
edition)

Settings for Active Directory such as
setting usage limitations and registered
printers for user information managed
using Active Directory or registering an IC
card compatibility table to Active Directory
need to be configured in the server
software.

Before registering the printer in the server
software, if you complete all settings for
the Active Directory first, the operation to
register user information managed in the
Active Directory or the IC compatibility
table to the printer can be performed
smoothly.

Active Directory settings can also be
configured after registering the server
software to the printer.

For details on Active Directory settings, see
chapter 6 "Syncing with Active Directory
User Information".

Configuring Database
settings (Only Enterprise
edition)

In order to export log or Job Account IDs
that are managed with the sever software
to the database, database settings need to
be configured in the server software.

If you complete the database settings
before registering the printer to the server
software, the operation for exporting logs
or Job Account IDs managed using the
server software to the database can be
performed smoothly.

Database settings can also be configured
after registering the server software to the
printer.

For details on the database settings, see
chapter 7 "Saving managed data to the
database".
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Adding a printer that
acquires the log

(Note!) A maximum 50 printers (In Enterprise
edition, 1,000 printers) can be
registered to the server software.

@ Select the [Printer] menu > [Add a
Printer].

@® Specify the printer that will acquire the
log.
<To search for a printer>
@ Select the search method.

<Local port or broadcast search>

D-1 Select [Search printers and select
from the list], check the port to
which the printer is connected, and
click [Next].

To search for printers in different
segments of the TCP/IP network, enter
the broadcast address. If it is unknown,
contact the network administrator.

<Searching for the printer from a CSV file>

®-1 Create a CSV file using software
such as Notepad or Excel etc.

<For Notepad>

i  Write the IP address and name of
each printer on one line for each
printer. Separate the IP address
and printer names with a comma
",". The printer name can be
omitted.

ii Save in text format with the
extension "CSV".

<For Excel>

i  Write the IP address and name of
each printer on one line for each
printer. The printer name can be
omitted.

ii Save in CSV file format.

D-2 Select [Import printers from a file],
and click [Reference].

MD-3 Specify the CSV file created in @,
and click [Open].

®-4 Click [Next].
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@ Select the printer from the list, and

click [Next].

Only printers that are supported by
Print Job Accouting are displayed.
Press and hold the Shift key or Ctrl key
while selecting to select more than 1
printer.

<To specify a printer directly>

@ Select [Specify the printer by
address], and select [Address]. When
connected to a TCP/IP network,
enter the printer IP address into [IP
Address].

@ Click [Next].
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® Set the printer to acquire the log, and
click [Finish].

Printer Name

Set the name of the printer to be displayed in the
server software.

Printer Group

Select the group that the printer belongs to.

Acquire Logs

Set the schedule by which the log is acquired.

(Note!) Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log is not acquired if the power is
not ON.

Interval

Set the interval when the log is acquired over
a fixed time. The maximum interval time that
can be set is 24 hours. The default setting is
set as an optimized value detected from the
state of the added printer. If the interval is

set to a time that is longer than the default
settings, some of the logs may not be acquired.

Time

Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

Fees

Set the fee definition pattern when assigning
printing costs to users.

Click [Define fees] to add definitions.

For details on the fee charge definitions, see
"Creating fee charge definitions" (page 84).

The initial settings definition shows
a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

Operation at Log Full
Set the process when the printer log buffer is full.

e Delete old logs
The oldest log is deleted, and the new log is
received.

e Cancel the job
All subsequent print jobs are cancelled.

¢ Do not acquire the log
The log is not obtained for subsequent print
jobs.
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Inhibit the initialization of the Hard Disk
and Flash Memory

Check this check box to prevent the printer built-
in hard disk, SD memory card, and flash memory
from being initialized. When Print Job Accouting is
used, always check this check box.

Auto Export Logs

Set to automatically write the acquired log to a
CSV format file, and send the file via e-mail.

e Do not automatically export
Automatic export is not performed.

e Automatically export logs
The acquired log is automatically written as
a CSV format file to the automatic export
destination.

e Mail logs to administrator
The acquired log is automatically written as
a CSV format file to the automatic export
destination, and the file is sent by e-mail to
the administrator.

Record logs in a database (Only
Enterprise edition)

Check to export the acquired log to a database.

Acquire Only Logs (do not use
restrictions)

Check this check box when you do not want to
automatically activate access restrictions for
models that have an access restriction function
on the control panel.

(Note!) Users cannot be registered.

Start acquiring the log immediately after
adding

Check this check box to start acquiring the log
after adding a printer.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
(Note! ¢ Depending on the printer, this is not
displayed.
e For details on the factory set printer

administrator password, see the User's
Manual of the printer.

Next, the "Job Account ID registration"
window is displayed.
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Registering the Job Account ® Enter the [Job Account ID], [Name], and
ID and Name [E-mail address] (can be omitted), and
click [Add].
The Job Account ID and Name can be
registered using the following method. The e-mail address needs to be set in
e Manual registration. [Notifies total result by e-mail] and
e Create a CSV file that contains the [Notifies by e-mail when Limit Value

Job Account IDs and User Names, and was exceeded] in step @.

register them in a batch.
e Users registered in Windows on the
network are read.
This section explains how to register
manually. For details on other methods,
see "Adding the Job Account ID"
(page 44).

@ Click [Add] in the [Job Account ID
registration].

O Click [Next].

@ Set functions for the Job Account ID, and
click [Next].

@® Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].
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Notifies total result by e-mail

Notifies the total amount used every month by
email.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for users that
belong to a printer group, and users that belong
to a printer group.

@® Set the use restrictions, and click [Next].

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In MONO

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to Email using panel operations.
Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.
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@ Set the limit values that can be used by
Job Account ID.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ©.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.
When limit values are set
@ click [Next], and proceed to step @.
When limit values are not set
@ Click [Finish], and proceed to step ©.

® Set the expiration date for the limit
values set in @, and click [Finish]. When
the valid period is exceeded, the limit
value count is reset.

Do not specify

The valid period is not set. When the limit value
set in @ is not set, printing is cancelled unless
the limit value is increased, or the usage status
are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

© When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!)' Depending on the printer, this may not
be displayed.
e For details on the factory set printer
administrator password, see the User's
Manual of the printer.
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@ Click [End] in the [Job Account ID
registration] window.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

Managing multiple printers
as a group

Multiple printers can be managed as

one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the user control values can
be set to all of the printers that belong to
the group.

@ Start the server software.

@® Select the [Printer] menu > [Manage
multiple printers as a group].

® Enter the printer group name, and click
[Next].

@ Select the printer to assign to the group
from the list, and click [Finish].

Add a printer group ﬂi‘

From the list, select the printers that pou want to manage as a group.

To select multiple consecutive printers, click the first printer, press and hold davin
SHIFT, and then click the last printer. To select multiple non-consecutive printers,
prezs and hold down CTRL, and then click on each printer.

Last Acquisition |

Group | Status

Printer | Address

<gack |[ Frsn || canca |

Press and hold the Shift key or Ctrl key
while selecting to select more than 1

printer.
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@ Register users to the group.
The Job Account ID registration window
is displayed. To register users, follow
the instructions in "Registering the Job
Account ID and Name" (page 29) and
register the users.

® The [Do you want to register the Job
Account ID registered in the group?]
window is displayed.
Click [Yes], and the user registered in
step @ is registered to the printer.

When limit values are set for users
or user groups that are registered to
printer groups, the limit values are
enabled for the total amount of usage
for users and user groups of all printers
that belong to the printer group.
However, the usage amount of users
and user groups that have the [Do not
process Limit Value as a group] check
mark checked are not included.

Changing the printer group

The printer can be changed to a different
group. This is useful for when the printer is
relocated to a different department.

@ Start the server software.

@® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer whose group you want
to change, and select the [Printer] menu
> [Change a Printer Group].

Multiple printers can be selected.

@ Select the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

® When the [Do you want to register the
Job Account ID registered in the group?]
window is displayed, click [Yes].

(Note!) When [No] is clicked, the users
registered to that group are processed
as unregistered users in that printer.

Deleting the printer group

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer group you want to
delete, and select the [Printer] menu >
[Delete a Printer/Printer Group].

Multiple printer groups can be selected.

O Click [Yes].

Printers that belong to the deleted
printer group are changed to [Not in a

group].

Backing up printer settings

Printer settings can be backed up. Backed-
up settings can be restored to a different
computer that has the server software
installed. This means that even if a
problem occurs with your computer, you
can continue using the same settings on

a different computer. Settings that can be
backed up are the printer settings, user
ID settings, fee settings, and user settings
that are synced with the Active Directory
(Only Enterprise edition).

@ Start the server software.

® Select the [Printer] menu > [Backup of
printer setting].
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® Specify the save location and file name of
the printer settings, and click [OK].

(Note!) e Store the backed-up setting file on a
different computer.

e We recommend creating a new
settings backup file each time the
software settings are changed.

e Acquired logs are not backed up.
Restoring printer settings
Backed-up printer settings are restored in
the server software.

@ Start the server software.

@® Seclect the [Printer] menu > [Add a
Printer].

® Select [Import printers from a file], and
specify the file path of the setting backup
file.

The extension of the settings backup file
is "dat".

You can also click the [Reference] button
and select the file.

O Click [Finish].
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® When the administrator password window
is displayed, enter the administrator
password and click [OK].

® When the printer registration results
notification window is displayed, click
[Close].
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Memo
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3. Setting up the client software

3. Setting up the client software

This section explains how to set up the print job accounting client software with plugins.

Setting up in Windows

Operating Environment

e Windows 7 / Windows 7 (64bit version)

e Windows Vista / Windows Vista (64bit
version)

e Windows Server 2008 R2

e Windows Server 2008 / Windows Server
2008 (x64 version)

e Windows XP / Windows XP (x64 version)

e Windows Server 2003 / Windows Server
2003 (x64 version)

e Windows 2000

Installing the Client Software

For details on how to install the client
software, see the “Installation Manual”.

Setting Job Accounting Mode

Job Accounting Mode is a method of
setting the User Name and Job Account
ID in the Windows client computer. There
are 4 modes. The default status is the
unsupported mode.

Job Accounting Mode settings can only
be configured in a print driver that
supports Print Job Accouting.

Tab

The tab for setting the User Name and Job
Account ID to the print driver properties is
displayed.

It is used by the user themselves to set or
change the User Name and Job Account ID.

Popup

A popup window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.

It is used when 1 computer is used by multiple
users.

(Note!) e Do not select this when using the
Windows XP simple user switching
function.

e Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use Hide for
shared printers.

e Popup mode cannot be selected for
Windows 7/Server 2008R2/Vista/
Server 2008.
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Hide

Even if printing is performed on the shared
printer client side, the input window is not
displayed. Use the hide mode for shared
printers. The system administrator creates an ID
file that contains the Job Account ID and User
Name that correspond to the Windows login user
in advance. By specifying this file with the client
software, the user that performed the printing

is identified, and the corresponding Job Account
ID is automatically acquired. Furthermore, the
same Job Account ID can be set for all login
users. The users do not need to configure
settings or to know their own Job Account ID.
When using the Windows computer as a print
server and the printer as a shared printer, install
and use the client software onto the computer to
be used as a print server.

Not supported

Users identification is not performed, and all
jobs are recognized as Unregistered ID. The
User Name is the user name used to login to
windows, and the Job Account ID is 0. Used
when user recognition is not needed.

This section explains how to set the tab
mode. For details on how to change other
modes, see "Changing Job Accounting
Mode" (page 130).

@ Select the printer driver of the printer
that will acquire the log from the
[Driver] list. To set all of the printer
drivers to the same mode, check [Set
the same mode for all drivers].

(Note!) When the shared printer is used,
do not use the function that sets all
printer drivers to the same mode.
When using a shared printer on
the client side to print, the account
information is not output.

@® Select [Tab], and click [Change].

® Click [OK] in the change successful
window.

O Select [File] menu > [Close].

@ In Windows 7/Server 2008 R2/Vista/
Server 2008m select [Start] > [Control
Panel], and click [Printer]. (For Windows
XP/Server 2003, select [Start] > [Printers
and FAX]. In Windows 2000, select
[Start] > [Settings] > [Printer]. )

® On the printer driver icon, right-click the
mouse button and select [Properties].

@ In the [Job Accounting] tab, enter the
User Name and Job Account ID.

In the default settings, the User Name is
the user name used to login to Windows,
and the Job Account ID is 1.

® Click [OK].
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Setting up in Mac OS Setting up in Mac OS X

(Note!) Depending on the model or print driver
used, the setting method or operating
environment may differ.

Operating Environment
Macintosh running Mac OS X 10.3 or later

When the printer drivers are installed in Mac
0S, the plugins are installed together. Set
the User Name and Job Account ID in the
[JobAccounting] panel of the print dialog.

(Note!) Depending on the model or print driver
used, the operating environment may
differ.

(Note!) If printing is performed without
configuring these settings, the User
Name is blank and the Job Account ID is
0 in the log.

Installing the client software

For details on how to install the client
software, see the “Installation Manual”.

The Client software is a utility for
registering, editing and managing
JobAccountingID for the job account.

Configuring the plugins
@ Set up the printer drivers in Mac OS.

@® Select the [File] menu > [Desktop Print]. Registering the

® Select the [JobAccounting] panel. JobAccountinglD
Double-click the Print Job Accouting icon.
Printer: Destination:
' g:::gr:l:mndPrinting @ Click [New].

Color Matching L1 Collated
Cover Page

Font Settings
Job Logging To:

e [ Je[ ]
Paper Handling

Plug-In Preferences
Save as File

)

s from: |[Auto Select

1]

gefrom: |Multi-Purpose Tray

Color Option
Color-0Office Color
~ Color-Graphics Prol
Color-Graphics Pro2
Job Option

Insert Option

Ak || 4

)
)

ing from: [ Multi-Purpose Tray

Ccaneer ) (o]

@® Enter the login name used for Mac OS X,
and the JobAccountingID and UserName

@O Set the User Name and Job Account ID,
and click [Save Settings].

Printer: | 830 =

Z1-8.7.1

Destination:

r [ JobAccounting

£l

Job Accounting Setting

User Name :

Job Account ID:

|sﬂtn |

! |

Save Settings

(o

@ Click [OK] in the confirmation window.

The current settings will be saved for
the printer “C830”.

[ Cancel

@® Click [Cancel] to close the dialog box.

for Print Job Accouting, and click [Save].

D

Repeat this operation to register

multiple users.
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@ Click [Save]. Registering multiple users

D together

Multiple JobAccountingID and UserName
can be registered using a CSV file. This is
useful when multiple login user names are
used in Mac OS X.

@ Use commercially available software to

prepare a CSV file.

In the CSV file, enter the Mac OS X login

name, JobAccountingID and UserName in

this order.

@ Using 1 line for each user, enter the Mac
0S X login name, JobAccountingID and
UserName.

® Save the CSV format file.

@ Enter the password, and click [OK].

@® Use the client software to register.

® Quit the client software. @D Double-click the Print Job Accouting icon.
@ Select Import from the file menu.
® Import the CSV file created in @.

@ Click [Savel].

® Enter the password, and click [OK].

)

® Quit the client software.
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Changing the
JobAccountingID and
UserName

The Client software can be used to change
JobAccountingID and UserName that have
already been registered.

@ Double-click the Print Job Accouting icon.

@® Select the user that you want to change,
and click [Edit].

® Enter the new JobAccountingID and
UserName, and click [Save].

O Click [Save].

)

@ Enter the password, and click [OK].

@® Quit the client software.

Deleting the
JobAccountingID and
UserName

@ Double-click Print Job Accouting.

@® Select the user that you want to delete,

and click [Delete].

To delete all registered users, click

[Delete All].

® Click [Save].

)

® Enter the password, and click [OK].

@ Quit the client software.
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4. Job Account ID Management

4. Job Account ID Management

This section explains how to add or delete a Job Account ID, how to change settings for the
Job Account ID use restrictions, and management of Job Account IDs.

(Note!) The window and setting contents differ depending on the printer model.

Adding the Job Account ID

Job Account IDs can be added as required.
Add them using one of the following
methods.
e Adding manually.
e Creating a user list file and adding in a
batch.
e Users registered in Windows on the
network are read.
For details on Job Account IDs, see
"Preparing User Information" (page 16).

Adding manually

@ Check that the printer power is ON.
@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O Select the printer or printer group,

and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ In the [User] tab, click [Register].
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@ Click [Add]. ® Enter the [Job Account ID], [Name], and
[E-mail address] (can be omitted), and
click [Add].

(Note!) If the names or user IDs duplicate
users that are already registered in the
printer, they cannot be added.

The e-mail address needs to be set in

[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in "Setting functions or
use restrictions" (page 49).

@ Select [Add a User], select the group that [:

the user belongs to from [User Group],
and click [Next].

© Click [Next].

Proceed to "Setting functions or use restrictions"
(page 49).
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Creating a CSV file to add in
a batch

Users can be added by creating a CSV file
that contains the Job Account ID, Name
and E-mail address, and importing the file.

(NOte’ If the User Names or Job Account IDs
in the CSV file duplicate users that are
already registered in the printer, the
printer information remains, and only
the names and Job Account IDs that are
not duplicated are added.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

@ Enter the Name, Job Account ID, and
E-mail address for each user on an
individual line. Enter the Job Account ID.
Separate the Name, Job Account ID and
E-mail address with a comma (,). The
E-mail address can be omitted.

Name Job Account ID

O

E-mail address

® Save in text format with the extension
“CSV".

<For Excel>

@ Enter the Name, Job Account ID and
E-mail address for each user on an
individual line. Enter the Job Account ID.
The E-mail address can be omitted.

Name Job Account ID

-

S

E-mail address

® Save in CSV file format.

® Check that the printer power is ON.
© Start the server software.

@ Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@® In the [User] tab, click [Register].
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@ Click [Add].

® Select [Add a User], select the group that
the user belongs to from [User Group],

and click [Next].

()

© Click [File].

@ Specify the CSV file created in @, and
click [Open].

@® Check that the Job Account ID and Name
have been added to the user list.

@® Click [Next].

Proceed to "Setting functions or use
restrictions" (page 49).
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Importing users registered in
Windows

User name information from Windows
specified on the network can be obtained
and registered as a batch to the server
software. Names that can be obtained
are accounts registered on the specified
computer.

(Note!) e Access permission for the specified

computer is required.

e If the names of users that are already
registered to the printer and those
registered to the computer are
duplicated, the printer information is
not imported, and only names that
are not duplicated are added.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

® In the [User] tab, click [Register].

® Click [Add].

@ Select [Add a User], select the group that
the user belongs to from [User Group],
and click [Next].

D

® Click [Remote Server].
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© Select the computer from which to obtain
user information from in [Import Source],
and click [Add].

Users that are registered as accounts
in the selected computer are added to
the [User] list. The Job Account ID is

assigned at random.

@ If user information that is not required
has been added, select Name, and click
[Delete].

® Click [OK].

@® Check that the Job Account ID and Name
have been added to the user list.

® Click [Next].

Proceed to "Setting functions or use
restrictions" (page 49).

Setting functions or use
restrictions

The following steps apply to all Job

Account IDs registered in the steps
from page 44 to page 49. These can be
changed for individual Job Account IDs
afterwards.

@ Set functions for the Job Account ID, and
click [Next].

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group.
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@® Set the use restrictions, and click [Next].

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail

Prohibits Scan to e-mail using panel operations.

Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Assign to a user group, and if [Do not
process Limit Value as a group] is not
checked in step @, click [Finish] and
proceed to step @. In other situations,
click [Next] and proceed to step ©.
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® Set the limit values that can be used by
Job Account ID.
When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step @.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the

number of times that the stapler can be used.

When limit values are set

w click [Next], and proceed to step @.

When limit values are not set

w click [Finish], and proceed to step @.

@O Set the valid period for the limit values
set in @, and click [Finish].
When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit value
set in @ is not set, printing is cancelled unless
the limit value is increased, or the usage status is
manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.
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® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].
(Note!) e Depending on the printer, this may
not be displayed.
e For details on the factory set printer

administrator password, see the User's
Manual of the printer.

@ Click [End] in the [Job Account ID
registration] window.

@ In the [Properties of printer from which
logs are acquired] window, click [OK].

Registering the same Job
Account ID to multiple
printers

The Job Account IDs and Names set in a
printer can be copied to a different printer.

(Note!) o If the Job Account ID or Name of
the users that are already registered
to the copy destination printer are
duplicated from users in the copy
source printer, the information in the
copy destination printer remains, and
only Names and Job Account IDs that
are not duplicated are added from the
copy source.

¢ Use restriction settings are also copied
together with the Job Account ID.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ In the [User] tab, click [Register].

® Click [Other Printer].
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@ Select a printer or printer group that Managing multiple users as a
already has user information registered group

from [Import Source], and click [Add].

Multiple Job Account IDs can be managed
as one group. When managed as a group,
the log can be displayed in group units.
Furthermore, the limit values can be set to
all of the users that belong to the group.

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer for which you want to
create a user group, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O Click [Registration] in the user tab.

® Click [Add].

The Job Account IDs and Names
registered in the selected printer or
printer group are added to the [User] list.

® If user information that is not required
has been added, select the Name, and

click [Delete]. (:

©® Click [OK].

@® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

® Check that the Job Account ID and Name

have been added to the user list.

@® Click [End] in the [Job Account ID
registration] window.

® In the [Properties of printer from which
logs are acquired] window, click [OK].
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@® Select [Management multiple Job Account
ID as a group], enter the [Group Name]
and [E-mail address] (can be omitted),
and click [Next].

The e-mail address needs to be set in
[Notifies total result by e-mail] and
[Notifies by e-mail when Limit Value
was exceeded] in step ©.

@ Select the user that you want to assign to
the group, and click [Next].

® Set the functions for the group, and click
[Next].

Notifies total result by e-mail

Notifies the total amount used every month by
email.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for user
groups of printers that belong to the printer
group.
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© Set the use restrictions, and click [Next].

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail

Prohibits Scan to e-mail using panel operations.

Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Create a user group in the printer group,
and if [Do not process Limit Value as a
group] is not checked in step @, click
[Finish] and proceed to step @®. In other
situations, click [Next] and proceed to step

®.
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@ Set the limit values that can be used by
the user group.
If the total amount used by all users that
belong to the group exceeds the limit
values, printing is cancelled for all users
that belong to the group until the valid
period set in step @.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.

When limit values are set

w click [Next], and proceed to step @.

When limit values are not set

w click [Finish], and proceed to step @®.

® Set the valid period for the limit values
set in @, and click [Finish].
When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit value
set in @ is exceeded, printing is cancelled unless
the limit value is increased, or the usage status is
manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.
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@® Click [End] in the [Job Account ID
registration] window.

® In the [Properties of printer from which
logs are acquired] window, click [OK].

Changing the user group

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer whose user group you

want to change, and then select the

[Printer] menu > [Properties].
Multiple printers can be selected.

O In the [User] tab, click [Register].

@ Select the user whose group you want to
change, and click [Change Group].
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@® Select the new group to be assigned to,
and click [OK]. To remove the printer
from all groups, select [Not in a group].

@ Click [End].

® Check that the group is changed, and
click [OK].

Deleting a Job Account ID
or User Group

(Note!) [Local Print], [Email To Print], and
[Unregistered ID] cannot be deleted.

@ Check that the printer power is ON.
@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

® In the [User] tab, click [Register].

@® Select the Name or Group Name from
the [List of registered IDs], and click
[Delete].

)

@ Click [Yes] in the confirmation window.

® Click [End] in the [Job Account ID
registration] window.

©® In the [Properties of printer from which
logs are acquired] window, click [OK].

When a user group is deleted, the users
that belonged to the deleted user group
are changed to [Not in a group].
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Changing Job Account ID
and User Group settings

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Seclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

® In the [User] tab, click [Register].

@® Select the Name or Group Name whose
settings you want to change from
the [List of registered IDs], and click
[Change].

@ Change the settings in the [Job Account
ID] (or [User Group] for groups), [User
Restrictions], and [Limit Value] tabs, and
click [OK].

Job Account ID tab

Name

This can be specified in a maximum of 80
characters. "™ cannot be used.

(Note!) The Job Account ID cannot be changed.
In order to change the Job Account ID,
delete the Job Account ID and then add
it again.

E-mail address

Enter to send an e-mail when the use amount or
limit values are exceeded.

User Group

Set the group to assign the user to.
If you do not want to assign the user to a group,
select [Not in a group].

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Value was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.
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Do not process Limit Value as a group

Printer limit values can be set individually for
users/user groups that belong to printer groups,
and users that belong to user groups.

User Restriction tab

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print In Mono

When disable color printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the color
printing prohibited settings are applied.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to E-mail
Prohibits Scan to e-mail using panel operations.
Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Limit Value tab

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.
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Valid Period

The valid period is displayed when limit
values are set. When the valid period is
exceeded, the limit value count is reset.

Do not specify

The valid period is not set. When the limit value
is exceeded, printing is cancelled unless the
limit value is increased, or the usage status is
manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

(Note!) e The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

o If the valid period is changed, a
confirmation window is displayed to
check whether or not to reset the
usage status. To reset the usage
status, click [Yes].

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

© Click [End] in the [Job Account ID
registration] window.

@ In the [Properties of printer from which
logs are acquired] window, click [OK].

Checking the usage status
of individual Job Account
IDs and User Groups

Checking the usage status

(Note!) To check or reset the usage status
including the log remaining in the
printer, first refer to "Immediately
acquiring the log" (page 192), and
acquire the log.

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1n the [User] tab, click [Register].

@ Select the Name or Group Name that you
want to check from the [List of registered
IDs], and click [Change].
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@® Check the [Usage Status] tab.

Printed Sheets

The number of sheets printed until now and the
remaining number of prints are displayed.

Fees

The fees incurred until now and the remaining fee
amount are displayed.

Staple

When the optional finisher is installed, the
number of times the stapler was used until now
and the remaining number of times are displayed.

e The usage status of the users and user
groups registered to the printer group

is the total usage amount of the users
and user groups from all printers that
belong to the printer group. Also, the
usage status of the user group is the
total usage amount of all users that
belong to the user group. However,
the usage amount of users and user
groups that have the [Do not process
Limit Value as a group] check mark
checked are not included.

e When a valid period is set for the
Job Account ID, when the period has
passed, the usage status value is
automatically reset to 0.

@ When the confirmation is completed, click
[OK].

® Click [End] in the [Job Account ID
registration] window.

© In the [Properties of printer from which
logs are acquired] window, click [OK].

Resetting the usage status

@ Follow the steps from @ to © in
"Checking the usage status" (page 59).

@® Check the [Reset] check box in the
[Usage Status] tab, and click [OK].

(Note!) If the [Status] in the [Job Account ID]
tab (or [User Group] tab for groups) is
"Disable Printing (Exceeded the limit
value)", it cannot be reset unless the
printer power is ON.

® Click [Yes] in the confirmation window.

O Click [End] in the [Job Account ID
registration] window.

@ In the [Properties of printer from which
logs are acquired] window, click [OK].

When the usage status of the user and
user group registered to the printer
group is reset, the usage status of the
users and user groups of all printers
that belong to the printer group are
reset. Also, when the usage status of a
user group is reset, the usage status of
all users that belong to the user group
are reset. However, the usage status
of users and user groups that have the
[Do not process Limit Value as a group]
check mark checked are not reset.
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Receiving log results by @ Click [OK].

e-mail @ Click [End] in the [Job Account ID

registration] window.
Log results can be notified by e-mail to the g ]

user every month. © In the [Properties of printer from which

logs are acquired] window, click [OK].

(Note!) The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).

eThe mail is sent of the day after the

deadline (default setting is end of
the month) set in the "Changing the
deadline" (page 191).

e Items to be logged can be changed
in "Changing the log items to be
exported" (page 197).

@ Start the server software.

@® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

® In the [User] tab, click [Register].

@ Select the user to set, and click
[Change].

@® Enter the E-mail address in the [E-mail
address] field of the [Job Account ID]
tab, and check the [Notifies total result
by e-mail] check box.
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Associating Job Account
IDs to authentication
users

In models that have an access restriction
function on the control panel in which
user name/password authentication is
being used, a Job Account ID can be
associated with user names that perform
authentication. When a Job Account ID is
associated with a user name, when that
user name/password are used to login to
the control panel, or when the user name/
password are set in the printer driver when
printing is performed, the use restrictions
associated with the Job Account ID are
enabled.

(Note!) «"Admin" cannot be specified as the
user name.

e The same Job Account ID can be
associated with different user names.

Adding manually

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ Click [Authentication User] in the [User]
tab.
The association between the user name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.
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@ Enter the [User Name] in the user name,
select the Job Account ID that you want
to associate with the user name from
[Job Account ID], and click [Add]. To
delete associations, select the association
that you want to delete from the
registration list, and click [Delete].

@ Click [Registration].

(Note!) e Register all associations between the
registration list user names and Job
Account IDs.

e The associations deleted from the
registration list are also deleted from
the printer.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) For details on the factory set printer
administrator password, see the User's
Manual of the printer.

©® When a message showing that the
process was successful is displayed, click
[OK].

@ Click [End].
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Creating a CSV file to add in
a batch

A CSV file that contains the User Name
and Job Account ID can be created, and
associations added to the user names and
Job Account IDs by importing the file.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

@ The authentication user and Job Account
ID are included for each user individually
on a separate line. The authentication
user and Job Account ID are separated
with a comma (,).

® Save in text format with the extension
||CSVII.
<For Excel>

@D The authentication user and Job Account
ID are included for each user individually
on a separate line.

® Save in CSV file format.

@® Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

@ Click [File].

® Specify the CSV file created in @, and
click [Open].

©® Check that the User Name and Job
Account ID have been added to the
registration list.

(Note!) When a Job Account ID that is not
registered to the printer is specified,
the registration list is not displayed. A
Job Account Id needs to be added in
advance.
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@ Click [Registration].

(Note!) e Register all associations between the
registration list User Names and Job
Account IDs.

e The associations deleted from the
registration list are also deleted from
the printer.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) For details on the factory set printer
administrator password, see the User's
Manual of the printer.

® When a message showing that the
process was successful is displayed, click
[OK].

® Click [End].

Importing users registered in
Windows

User name information can be acquired
from Windows specified on the network,
and a Job Account ID can be associated.
User names that can be obtained are
accounts registered on the specified
computer.

(Note!) Access permission for the specified
computer is required.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

@ In the [User] tab, click [Authentication
User].
The association between the User Name
registered to the printer and Job Account
ID is acquired and displayed in the
register list.

@® Click [Remote Server].
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@ When the computer from which user
information is acquired is selected in
[Import Source], the acquired User Name
is displayed in the [User] list.

® Select the user name from the [User
Name] list, select the Job Account ID to
be associated from the [Job Account ID]
list and click [Add], and the User Name
and Job Account ID are added to the
[User] list.

© Click [OK].

@ Check that the User Name and Job
Account ID have been added to the
registration list.

® Click [Register].

(Note!) e Register all associations between the
registration list User Names and Job
Account IDs.

e The associations deleted from the
registration list are also deleted from
the printer.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

® When a message showing that the
process was successful is displayed, click
[OK].

® Click [End].
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Importing from a different @ Select the printer from which user
. information is acquired in [Import
prlnter Source] and click [Add], and the User
The associations of User Names and Job Names and Job Account IDs are added to
Account IDs set in a printer can be copied the [User] list.

to a different printer.

® Click [OK].

(Note!) If the associations between User Names
and Job Account IDs already registered
in the copy destination printer are
duplicated by those in the copy source
printer, the copy destination information
remains, and the associations of User
Names and Job Account IDs that are not
duplicated are added.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Seclect the printer or printer group,
and then select the [Printer] menu >
[Properties].

Multiple printers can be selected.

©® Check that the User Name and Job

@ In the [User] tab, click [Authentication Account ID have been added to the
User]. registration list.
The association between the user name @ Click [Registration].

registered to the printer and Job Account

ID is acquired and displayed in the (Note!) e Register all associations between the

registration list user names and Job

register list. Account IDs.
@® Click [Other Printer]. e The associations deleted from the
registration list are also deleted from
the printer.

- 69 -



4. Job Account ID Management

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

® When a message showing that the
process was successful is displayed, click
[OK].

® Click [End].
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Setting use restrictions to the login name
Setting use restrictions to the application name
Setting use restrictions to the document name
Setting use restrictions to the host name
Adding settings to printers

Displaying use restrictions that are already
registered in printers

Deleting use restrictions

Changing use restrictions

Deleting all use restrictions
Temporarily disabling use restrictions

Enabling use restrictions




5. Managing use restrictions

5. Managing use restrictions

This section explains how to manage use restrictions, such as adding or deleting use
restrictions to login names, application names, document names (URL), and host names

included in print jobs.

Setting use restrictions to
the login name

If required, use restrictions can be set to
the login name. Add the settings using one
of the following methods.

e Adding manually

e Adding from the log

e Creating a login name list file and adding
in a batch

e Users registered in Windows on the
network are read
Adding manually
@ Check that the printer power is ON.
@® Start the server software.

® Click the [Policy] menu > [Edit Policy].

O Click the [Login Name] tab.

O

® Select [Manual] as the registration
method.

@® Enter the login name that you want to
add settings to in the login name input
field.

@ Select the use restrictions that you want
to use.
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Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

® Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

-

© Click [Add] at the bottom of the window.

-

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding from the log

Use restrictions can be set to the login
names included in an acquired log.

@ Check that the printer power is ON.

@® Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ Select [Log] as the registration method.

@® Select the login name that you want to
add settings from the list to.

@ Seclect the use restrictions that you want
to use.
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Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
® Click [Add] in the Policy field.
The added login name and use

restrictions are displayed in the [Policy
for Login Name] list.

-

© Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note!) If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Creating a CSV file to add in
a batch

You can create a CSV file that contains the
login names, and add settings to the login
names by importing the file.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

@ Wwrite 1 login name on each line.

® Save in text format with the extension
"CSV".

<For Excel>

@ Write 1 login name on each line.
@ Save in CSV file format.
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@® Start the server software.
® Click the [Policy] menu > [Edit Policy].
@ Click the [Login Name] tab.

@ Select [File] as the registration method.

@® Click [Select File], specify the CSV file
that you created in step @, and click
[Open].

@ Select the login name that you want to
add settings from the list to.

® Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

©® Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

-

@ Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Importing users registered in
Windows

User name information from Windows
specified on the network can be obtained
and registered as a batch to the server
software. Names that can be obtained
are accounts registered on the specified
computer.

(Note!) e Access permission for the specified
computer is required.

o If the names of users that are already
registered to the printer and those
registered to the computer are
duplicated, the printer information is
not imported, and only names that are
not duplicated are added.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ Select [Server/Network] as the
registration method.

@ Click [Server].

O

@ Select the computer from which the login
names are acquired.

® Select the login name that you want to
add settings from the list to.

© Select the use restrictions that you want
to use.
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Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added login name and use
restrictions are displayed in the [Policy
for Login Name] list.

O

® Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note!) If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding unregistered item
settings

Use restrictions can be set for login names
that are not registered on the printer.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Login Name] tab.

@ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that

point onwards is cancelled.
Disable Printing

Cancels printing.
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@® Check the [Add Unregistered Item] check
box.
The [Other Login Names] and their use
restrictions are displayed in the [Policy
for Login Name] list.

—

@ Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Setting use restrictions to
the application name

If required, use restrictions can be set to
the application name. Add the settings
using one of the following methods.

e Adding manually

e Adding from the log

Adding manually

@ Check that the printer power is ON.
@® Start the server software.
® Click the [Policy] menu > [Edit Policy].

@ Click the [Application] tab.

-

@ Enter the application name that you want
to add settings to in the application name
input field.

)
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@® Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.

O

® Click [Add] at the bottom of the window.

-

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers"
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding from the log

Use restrictions can be set to the
application names included in an acquired
log.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
@ Click the [Application] tab.

@ Select the application name that you
want to add settings from the list to.

@® Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added application name and use
restrictions are displayed in the [Policy
for Applications] list.

-

® Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding unregistered item ® Check the [Add Unregistered Item] check
: box.
settings The [Other Applications] and use
Use restrictions can be set for application restrictions are displayed in the [Policy
names that are not registered on the for Applications] list.
printer.

@ Check that the printer power is ON.
@® Start the server software.
® Click the [Policy] menu > [Edit Policy].

O Click the [Application] tab. G

@ Select the use restrictions that you want
to use.

@ Click [Add] at the bottom of the window.

Enable Printing D

Allows printing.

Print in Mono Proceed to “Adding settings to printers”
When color printing is executed, printing is output (RGeS ERl),
in monochrome.

Disable Color Printing (Note!) If the "Adding settings to printers”
Cancels color printing. If there is color data part- (page 89) steps are not executed, the

set use restrictions are not registered to

way through a print job, all printing from that
the printer.

point onwards is cancelled.
Disable Printing

Cancels printing.
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Setting use restrictions to
the document name

If required, use restrictions can be set
to the document name. Add the settings
using one of the following methods.

e Adding manually

e Adding from the log

Adding manually

@ Check that the printer power is ON.
@® Start the server software.
® Click the [Policy] menu > [Edit Policy].

@ Click the [Document] tab.

O

@ Enter the document name that you want
to add settings to in the document name
input field.

* (Asterisk) can be used as a wild card

in the document name. However, items
that are just * or contain ** cannot be
registered.

@® Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added document name and use
restrictions are displayed in the [Policy
for Document Names/URLs] list.

-
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® Click [Add] at the bottom of the window.

-

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding from the log

Use restrictions can be set to the document
names included in an acquired log.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Document] tab.

@ Select the document name that you want
to add settings from the list to.

@ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
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@ Click [Add] in the Policy field.
The added document name and use
restrictions are displayed in the [Policy
for Document Names/URLs] list.

)

® Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note!) If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.

Adding unregistered item
settings

Use restrictions can be set for document
names that are not registered on the
printer.

@ Check that the printer power is ON.

@® Start the server software.

® Click the [Policy] menu > [Edit Policy].
@ Click the [Document] tab.

@ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.
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® Check the [Add Unregistered Item] check Setting use restrictions to
box.

The [Other URLs] and use restrictions the host name
are displayed in the [Policy for Document If required, use restrictions can be set to
Names/URLs] list. the host name.
Add the settings using one of the following
methods.

e Adding manually
e Adding from the log

Adding manually

>

@ Check that the printer power is ON.

@® Start the server software.

@ Click [Add] at the bottom of the window. ® Click the [Policy] menu > [Edit Policy].
O Click the [Host] tab.

O

O

Proceed to “Adding settings to printers”
(page 89). ® Enter the host name that you want to add
settings to in the host name input field.

(Note! If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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@® Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.

® Click [Add] at the bottom of the window.

-

Proceed to “Adding settings to printers”
(page 89).

(Note! If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding from the log

Use restrictions can be set to the document
names included in an acquired log.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
O Click the [Host] tab.

@ Select the host name that you want to
add settings from the list to.

@ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@ Click [Add] in the Policy field.
The added host name and use restrictions
are displayed in the [Policy for Host
Names] list.

® Click [Add] at the bottom of the window.

-

Proceed to “Adding settings to printers”
(page 89).

(Note!) If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding unregistered item
settings

Use restrictions can be set for host names
that are not registered on the printer.

@ Check that the printer power is ON.

@ Start the server software.

® Click the [Policy] menu > [Edit Policy].
@ Click the [Host] tab.

@ Select the use restrictions that you want
to use.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Disable Printing

Cancels printing.

@® Check the [Add Unregistered Item] check
box.
The [Other Host Names] and use
restrictions are displayed in the [Policy
for Host Names] list.

)

@ Click [Add] at the bottom of the window.

O

Proceed to “Adding settings to printers”
(page 89).

(Note!) If the "Adding settings to printers”
(page 89) steps are not executed, the
set use restrictions are not registered to
the printer.
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Adding settings to
printers

The set use restrictions can be added to
the printer.

(Note!) The use restrictions of items that are
already registered and exist in the
printer are changed.

@ Select the printer that you want to add
use restrictions to, and click [Add].
Printers that can have use restrictions
added are displayed in the [Selected
Printer] list. To add use restrictions to all
of the printers, click [Add All]. To exclude
printers from having use restrictions
added, select the printer in the displayed
[Selected Printer] list, and click [Delete].

O

@ Click [Apply].

O

® When the administrator password window
is displayed, enter the administrator
password and click [OK].

Displaying use restrictions
that are already
registered in printers

@ The use restrictions that are already
registered in printers can be displayed.

@® Check that the printer power is ON.
© Start the server software.
O Click the [Policy] menu > [Edit Policy].

@ Select the printer, and click [Acquire

Policy].
)

@® The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.
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Deleting use restrictions

Use restrictions that are registered in
printers can be deleted.

@ Check that the printer power is ON.
@® Start the server software.
® Click the [Policy] menu > [Edit Policy].

@ Select the printer, and click [Acquire

Policy].
o

® The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

@® Select the use restriction that you want
to delete from the user restriction list,
and click [Delete]. The use restriction
display is deleted from the use restriction
list.

@ Click [Update] at the bottom of the
window.

® Select the printer that you want to delete
use restrictions from, and click [Add].
Printers that can have use restrictions
deleted are displayed in the [Selected
Printer] list. To delete use restrictions
from all of the printers, click [Add All].
To exclude printers from having use
restrictions deleted, select the printer in
the displayed [Selected Printer] list, and
click [Delete].

© Click [Apply].
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@® When the administrator password window
is displayed, enter the administrator
password and click [OK].

(Note!) Unregistered items such
as OtherLoginNames,
OtherApplicationNames, OtherURLs, and
OtherHostNames cannot be deleted.

Changing use restrictions

Use restrictions that are registered in
printers can be changed.

@ Check that the printer power is ON.
@® Start the server software.
® Click the [Policy] menu > [Edit Policy].

@ Select the printer, and click [Acquire

Policy].
(S

® The registered use restrictions are
displayed in the use restriction lists in
each of the [Login Name], [Application],
[Document] and [Host] tabs.

@® Select the Name of the use restrictions
that you want to change from the
use restriction list, and select the use
restriction.

Enable Printing
Allows printing.
Print in Mono

When color printing is executed, printing is output
in monochrome.

Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.
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Disable Printing

Cancels printing.

@ Click [Change]. The changed use
restrictions are displayed in the use
restrictions list.

® Click [Update] at the bottom of the
window.

O

© Select the printer that you want to
change the use restrictions for, and
click [Add]. Printers that can have use
restrictions changed are displayed in the
[Selected Printer] list. To change use
restrictions for all of the printers, click
[Add All]. To exclude printers from having
use restrictions changed, select the
printer in the displayed [Selected Printer]
list, and click [Delete].

@ Click [Apply].

)

® When the administrator password window
is displayed, enter the administrator
password and click [OK].
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De|eting all use ® When the administrator password window
. . is displayed, enter the administrator
restrictions password and click [OK].

All of the use restrictions set for the Login
Name, Application Name, Document Name
and Host Name can be deleted.

@ Check that the printer power is ON.
@® Start the server software.

® Click the [Policy] menu > [Delete All
Policy].

@ Select the printer that you want to delete
all of the use restrictions from, and click
[Add]. Printers that can have all use
restrictions deleted are displayed in the
[Selected Printer] list. To delete all use
restrictions from all of the printers, click
[Add All]. To exclude printers from having
all use restrictions deleted, select the
printer in the displayed [Selected Printer]
list, and click [Delete].

@ Click [Apply].
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Temporarily disabling use
restrictions

Use restrictions can be temporarily
disabled. The use restrictions set for the
Job Account ID for printing jobs from a PC
are also disabled.

@ Check that the printer power is ON.
@® Start the server software.

® Click the [Policy] menu > [Disable

Policy].

Select the printer whose use restrictions
you temporarily want to disable, and
click [Add]. Printers that can have use
restrictions temporarily disabled are
displayed in the [Selected Printer] list. To
temporarily disable use restrictions for all
of the printers, click [Add All]. To exclude
printers from having use restrictions
temporarily disabled, select the printer in
the displayed [Selected Printer] list, and
click [Delete].

@ Click [Apply].

-

® When the administrator password window
is displayed, enter the administrator
password and click [OK].
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Enabling use restrictions © Click [Apply].

Use restrictions that were temporarily
disabled can be enabled again.

@ Check that the printer power is ON.
@® Start the server software.

® Click the [Policy] menu > [Enable Policy].

O

® When the administrator password window

is displayed, enter the administrator

assword and click [OK].
O Select the printer whose use restrictions P [OK]

you want to enable again, and click
[Add]. Printers that can have use
restrictions enabled again are displayed
in the [Selected Printer] list. To enable
use restrictions again for all of the
printers, click [Add All]. To exclude
printers from having use restrictions
enabled again, select the printer in the
displayed [Selected Printer] list, and click
[Delete].
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Memo
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6. Syncing with Active Directory User Information

6. Syncing with Active Directory User

Information

This section explains how to add or delete use restrictions or change settings for user
information managed by Active Directory, and how to sync with Active Directory user

information.

Setting the printer to
be linked with Active
Directory

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O Click the [Option] tab > [Detail setting].
21|

Printerl User  Option |

Acquire Logs
@ |nteryval
I? Hour ID Minutes
" Time
Lhange Time... |
Fees Cad41/0831/0822 j
Define fees... |
DOperation at Lag Full IDeIete old logs j
Auta Export Logs IDD hiot automatically expart j
I™ | Becord logs in & database
Click [Dietall setting] ta cooperate with
Active Directory.

ok | x|

@® Check the [Synchronize user list with
Active Directory] check box.

@® Select [Policy based printing].
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User is identified by Job Account ID

Print restrictions from a registered user PC are
set in the Job Account ID. For jobs from PCs, the
Job Account ID needs to be set in advance in the
client software driver of the print source PC.

User is identified by PC Login name/card

Print restrictions from an unregistered user PC
are set in the login name. The client software
does not need to be installed in the print source
PC.

@ Click [OK].

@ Click [OK] at the bottom of the window.
[Properties of printer from which logs are acquire 21

Printer' Uzer  Option |

Acquire Logs
& |nterval
7 Houw IU Mirutes
" Time
Lhange Time... |
Eees Ca41/C831 /0822 j
Diefine fees... |
Operation at Log Full IDeIete ald lags j
#Auto Export Logs IDo not automatically export j
I | Becord logs in & database
Click [Detail zetting] to cooperate with Detail setting... |
Active Directary. -

— e Em |

© If the settings for creating an IC card
compatibility table are not set, a message
notifying that the IC card compatibility
table cannot be registered to the printer
is displayed. Click [OK].
In order to register an IC card
compatibility table to the printer,
the settings for creating an IC card
compatibility table need to be configured.
For details on the settings required for
creating an IC card compatibility table,
see "Creating an IC card compatibility
table" (page 129).

@® When the window notifying the changes
to setting items is displayed, click [Yes].

® When the window notifying that
the setting changes are complete is
displayed, click [Close].

® When the [Login name/Group name
which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see the
100 page.
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Configuring the Active
Directory settings

Configure the connection destination and
other such settings for the Active Directory
that is linked to the server software.
Connecting to the currently logged-on
Active Directory

@ Click [Policy] menu > [User Registration
on Active Directory].

@® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

® Click [Add] in the [Active Directory User/
Group Settings].

@ Click [Options] in the [Active Directory
Search].

@® Check the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].
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@® To change the port number to which ® To search for users that have locked
Active Directory connects, enter the [Port accounts, check the [Search for locked
Number]. The range of the port number users] check box.

is from 1-65535.

)

© Click [OK].
@ To change the search target, enter [Base
DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local
When OU is specified: OU=0U name,
DC=domain, DC=local
If these values are not entered, the
search is made based on DC=domain,
DC=local.

When OU is specified, the time required
to complete the search can be reduced.
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Connecting to an Active
Directory in a specified
domain

@ Click [Policy] menu > [User Registration
on Active Directory].

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

)

® Click [Add] in the [Active Directory User/
Group Settings].

O Click [Options] in the [Active Directory
Search].

® Uncheck the [Set Up Active Directory] tab
in [Search the currently logged on Active
Directory].

@® Enter the [Domain Name], [Logon Name]
and [Password].

Domain Name

Enter the Active Directory domain name for
searching for the user and group.

Logon Name

Enter the user name for logging on to the Active
Directory.
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Password

Enter the password for logging on to the Active
Directory.

@ To change the port number to which
Active Directory connects, enter the [Port
Number]. The range of the port number
is from 1-65535.

® To change the search target, enter [Base
DN]. An example input when the domain
name is [domain.local] is shown below.
When there is no OU: CN=Users,
DC=domain, DC=local
When OU is specified: OU=0U name,
DC=domain, DC=local
If these values are not entered, the
search is made based on DC=domain,
DC=local.

The search time can be reduced by

specifying the OU because the search is
only performed within the specified OU.

© To search for users that have locked
accounts, check the [Search for locked
users] check box.

)

@ Click [OK].
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To add attributes to the
displayed user list

@ Click [Policy] menu > [User Registration
on Active Directory].

@® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

.

® Click [Add] in the [Active Directory User/
Group Settings].

O Click [Options] in the [Active Directory
Search].

@ Select the items that you want to display
in the [Choose Columns] tab > [Viewable
Column], and click [Add].

)

@ Click [OK].

- 104 -



6. Syncing with Active Directory User Information

To hide attributes in the user @ Click [Options] in the [Active Directory
list Search].

@ Click [Policy] menu > [User Registration
on Active Directory].

@® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

@ Display the [Choose Columns] tab. a

@® Select the items that you want to hide in
[Column to View], and click [Remove].

)
)

® Click [Add] in the [Active Directory User/
Group Settings].

@ Click [OK].
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To change the order of
attributes displayed in the
user list

@ Click [Policy] menu > [User Registration
on Active Directory].

@ Click [Setup] in the [Login name/Group

name which synchronizes with Active
Directory] window.

® Click [Add] in the [Active Directory User/
Group Settings].

O Click [Options] in the [Active Directory
Search].

® Display the [Choose Columns] tab.

@® Select the items that you want to change
the order of in [Column to View], and
click [Up] or [Down].

@ Click [OK].
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Specifying attributes for ® Click [Add] in the [Active Directory User/
obtaining IC card information Group Settings].

IC card information (card ID) registered
in the Active Directory attributes can be
obtained, and the IC card compatibility
table can be added when an Active
Directory user is added. This setting
requires the IC card compatibility table to
be registered to the printer.

@ Click [Policy] menu > [User Registration
on Active Directory].

@ Click [Setup] in the [Login name/Group
name which synchronizes with Active

Click [Options] in the [Active Director
Directory] window. 4] [Op ] [ y

Search].

@ Display the [IC Card] tab.
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® Check the [Gets IC card information Adding an Active Directory
from Active Directory] check box, and
enter the name of the attribute in which user
IC card information stored by the Active Search for the user or group from the

Directory in [Attribute]. Active Directory, and use restrictions or

limit values can be set.

Searching for users

@ Start the server software.

@® Click [Policy] menu > [User Registration
on Active Directory].

@ Click [OK].

® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

)

The Active Directory attribute name
that you created yourself can also be
specified.

(Note!) e Primary attribute items such as "cn" D

cannot be used as attributes for IC
card information.

o If an invalid attribute name is
specified, IC card information cannot
be obtained.
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O Click [Add] in the [Active Directory User/
Group Settings].

@ Enter the search conditions into the
[Active Directory Search] window, and
click [Start Search]. To stop the search,

click [Stop].

(Note!) The search cannot be performed
unless the Active Directory connection
destination is set. For details on
setting the Active Directory connection
destination, see page 102.

Name

Enter the character string that you want to search
from the Active Directory display name, surname,
name, and Name. Items that match the beginning
of the entered character string are displayed. If
items have been entered into the [Description]
column, items that match both are displayed.

Description

Enter the character string that you want to search
the Active Direction explanation for. Items that
match the beginning of the entered character
string are displayed. If a character string has
been entered into the [Name] column, items that
match both are displayed.

Type

Select the Active Directory search target. Groups
or users can be set as search targets.

o If the [Start Search] button is clicked

when the [Name] and [Description]
sections are blank, the search is
performed for all users or groups.

e "*" can be entered as a wild card
for [Name] and [Description]. "*"
represents more than 0 character
strings.

@® The groups or users are displayed in the
[Active Directory Search] window.
To set use restrictions or limit values,
select the group or user and click
[Settings].

When setting use restrictions or limit
values for groups, the same use
restrictions are set for the users that
belong to that group. However, use
restrictions or limit values can also be set
for specific users or groups that belong to
the group.
e To set use restrictions or limit values for
groups or users, proceed to "Setting use
restrictions or limit values" (page 110).

e To set use restrictions or limit values
for specific users or groups that belong
to groups, proceed to "Referencing
members that belong to groups”

(page 110).
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Referencing members that
belong to groups

Use restrictions or limit values can also be
set for specific users or groups that belong
to the group.

@ Select a group from those displayed in
the [Active Directory Search] window,
and click [Member Reference].

)

@® Users that belong to the group are
searched. To stop the search, click
[Stop]. To search the users that belong to
the group again, click [Re-search].

® Select a group or user displayed in the
[List of Members Belonging to Selected
Group] window, and click [Settings].

)

Proceed to "Setting use restrictions or limit
values" (page 110).

Setting use restrictions or
limit values

@ Set the use restrictions in the [Use
Restrictions] tab.

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print in Mono

When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.

Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the Disable Printing
settings are followed.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to Email

Prohibits Scan to Email using panel operations.
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Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Values was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group. When [Do not
process Limit Value as a group] is unchecked, if
the total amount used by users that belong to the
group exceeds the specified limit value, printing
of all users that belong to the group is cancelled.
When [Do not process Limit Value as a group] is
checked, if the total amount used by users that
belong to the group exceeds the specified limit
value, printing of the users whose print total
exceeds the limit value is cancelled.

@® Set the limit values in the [Limit Values]
tab.

When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ©.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.

If the limit value was set, proceed to step @©.
If the limit value was not set, proceed to
step @.
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@ Set the valid period for the limit value set
in step ©.

When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit
value set in @ is not set, printing is cancelled
unless the limit value is increased, or the usage
conditions are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

O Click [OK].

(Note!) e The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.

e The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 118).
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Copying user settings from Applying settings to the
other groups printer
The settings of groups or users whose use
restrictions or limit values are completed The following steps apply to all users
can be copied to other groups or users. registered in the steps from page 98
to page 112. These can be changed for
@ Select the copy destination group or user each user later.

in the Active Directory Search window.

@ Click [End] in the [Active Directory
Search] window.

@® Click [Copy Setting].

@® Click [End] in the [Active Directory User/
Group Settings] window.

® Select the group or user whose settings
are to be copied, and click [OK].

- 113 -



6. Syncing with Active Directory User Information

® When the [Assign Job Account ID] ® When the administrator password window
window is displayed, assign a Job Account is displayed, enter the administrator
ID to users that currently do not have a password and click [OK].

Job Account ID assigned, and click [OK].
For details on how to assign Job Account
IDs, see "Assigning a Job Account ID to
an Active Directory user" (page 121).

@ When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.

O Click [Apply] in the [Login name/Group
name which synchronizes with Active
Directory] window.

)

® When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].
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Changing Active Directory O Seclect the user in the [Active Directory
. User/Group Settings] window, and click
user settlngs

[Change].
The use restrictions or limit values set to
the Active Directory users or groups can be
changed.
Changing use restrictions or limit values

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

@ Set the use restrictions in the [Use
Restrictions] tab.

Disable Printing
Cancels printing.
Disable Color Printing

Cancels color printing. If there is color data part-
way through a print job, all printing from that
point onwards is cancelled.

Print in Mono

When Disable Color Printing is set, monochrome
printing is performed without cancelling color
data.
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Disable Copying

Copying using panel operations is prohibited.
When this is disabled, the printing prohibited
settings are applied.

Disable Color Copying

Color copying using panel operations is
prohibited. When this is disabled, the Disable
Color Printing settings are followed.

Disable USB Memory to Print

Prohibits printing from a USB memory using
panel operations.

Disable USB Memory to Color Print

Prohibits color printing from a USB memory using
panel operations.

Disable Scan to Email
Prohibits Scan to Email using panel operations.
Disable Scan to Network PC

Prohibits Scan to network PC using panel
operations.

Disable Scan to USB Memory

Prohibits Scan to USB memory using panel
operations.

Disable Fax Sending

Fax sending using panel operations is prohibited.
Fax sending that uses the fax driver is also
cancelled.

Disable Scan to Internet Fax

Prohibits scan to internet fax using panel
operations.

Disable Scan to Fax Server

Prohibits scan to fax server using panel
operations.

Notifies total result by e-mail

Notifies the total amount used every month by
e-mail.

Notifies by e-mail when Limit Values was
exceeded

A mail notification is sent when the print quantity
exceeds the limit value and printing is no longer
possible, and when the limit value is reset and
printing is made possible again.

Do not process Limit Value as a group

Limit values can be set individually for printer
users that belong to a printer group, and users
that belong to a user group. When [Do not
process Limit Value as a group] is unchecked, if
the total amount used by users that belong to the
group exceeds the specified limit value, printing
of all users that belong to the group is cancelled.
When [Do not process Limit Value as a group] is
checked, if the total amount used by users that
belong to the group exceeds the specified limit
value, printing of the users whose print total
exceeds the limit value is cancelled.

@ Set the limit values in the [Limit Values]
tab.

When each of the limit values is
exceeded, printing is cancelled until the
valid period set in step ©.

(Note!) The limit value settings are enabled
from the point at which the server
software obtains the log when the limit
value has been exceeded. Printing can
still be performed when the limit value
is exceeded until the server software
receives the log.

Printed Sheets

Set the number of sheets that can be printed.
Fees

Set the upper limit of the fee charges.
Staple

When the optional finisher is installed, set the
number of times that the stapler can be used.

If the limit value was set, proceed to step @.
If the limit value was not set, proceed to
step ©.
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@ Set the valid period for the limit value set
in step @.

When the valid period is exceeded, the
limit value count is reset.

Do not specify

The valid period is not set. When the limit
value set in @ is not set, printing is cancelled
unless the limit value is increased, or the usage
conditions are manually reset.

By month

Set the valid period in month units. Set the
number of months and base date (10th, 20th,
end of month, deadline).

By week

Set the valid period in week units. Set the
number of weeks and base day.

By day

Set the valid period in day units. The number of
days is set.

Carry over unused value to the next valid
period

Check to carry over the amount that is not used
within the valid period to the next period.

© Click [OK].

(Note! e The use restrictions for users that
belong to multiple groups are all
set to prohibited when the multiple
groups are set to prohibited. Printing
and copying etc, are set to printing
(copying) available, Print in Mono,
color printing (copying) unavailable,
and printing (copying) unavailable in
this priority order.

e The limit values are taken as those
from the group with the highest
priority level. To change the priority
of groups, see "Changing the priority
level of groups" (page 118).

- 117 -



6. Syncing with Active Directory User Information

Changing the priority level of User/Group Settings] window, and click
[Change].
groups

When users that are set with use
restrictions or limit values belong to
multiple groups, the priority level at which
group use restrictions or limit values are
applied to users can be changed. The use
restrictions or limit values of the highest
priority level group are assigned to the
user.

@ Start the server software.

@® Click [Policy] menu > [User Registration
on Active Directory].

@ Click the [Limit Values] tab > [Set

® Click [Setup] in the [Login name/Group Priorities].
name which synchronizes with Active
Directory] window.

@® Select the group whose priority you want

O Select the user in the [Active Directory
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to change in the [Set Priorities] window,
and click [Up] or [Down].

@ Click [OK].

(Note!) The priority order settings are applied to
all users that belong to the group.

Applying settings to the
printer
@ Click [Apply] in the [Login name/Group

name which synchronizes with Active
Directory] window.

D

® When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

® When the administrator password window
is displayed, enter the administrator
password and click [OK].

©® When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.
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Deleting an Active
Directory user

The use restrictions or limit values set to
the Active Directory users or groups can be
deleted.

@ Start the server software.

@® Click [Policy] menu > [User Registration
on Active Directory].

® Click [Setup] in the [Login name/Group
name which synchronizes with Active
Directory] window.

O Select the user in the [Active Directory
User/Group Settings] window, and click
[Removel].

@ When the user delete confirmation
window is displayed, click [Yes].

® Click [End].

@ Click [Apply] in the [Login name/Group
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name which synchronizes with Active
Directory] window.

® When the confirmation window appears
confirming whether or not to apply use
restrictions to the printer, click [OK].

©® When the administrator password window

is displayed, enter the administrator
password and click [OK].

@ When the settings for registering the IC
card compatibility table to the printer are
enabled, a window inquiring whether or
not to register the IC card compatibility
table to the printer is displayed. Click
[Yes] to send the IC card compatibility
table to the printer, or [No] to not send
the IC card compatibility table to the
printer.

Assigning a Job Account
ID to an Active Directory
user

Active Directory users that are set with
use restrictions or limit values must be
assigned with a unique Job Account ID.
There are two methods for assigning a Job
Account ID to an Active Directory user that
is set with use restrictions or limit values,
which is done when the user is added

to the Active Directory. These are the
automatic method or the manual method.

Automatically assigning a
Job Account ID

When the setting for automatically
assigning the Job Account ID is enabled,

a unique Job Account ID can be
automatically assigned to a user when the
user is added to the Active Directory.

@ Start the server software.

@® Click [Policy] menu > [User Registration

on Active Directory].

® In the [Login name/Group name which

synchronizes with Active Directory]
window, check the [Auto Assign Job
Account ID] check box.
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Manually assigning a Job @ Select the user to assign the Job Account
Account ID ID to in [User], and click [Change].

When [Auto Assign Job Account ID] in

the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A unique Job
Account ID can be assigned manually to
the user.

@ Check the [Only display non-assigned
login name] check box.

O Click [OK].

@® Enter the Job Account ID to be assigned
in the [Job Account ID] column.

(NOte!) These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step @ is
clicked.
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Assigning a Job Account ID
from a file

When [Auto Assign Job Account ID] in

the [Login name/Group name which
synchronizes with Active Directory] window
is disabled, the [Assign Job Account ID]
window is displayed when a user is added
to the Active Directory. A Job Account ID
can be assigned to the user by creating

a CSV file that contains the user name

and Job Account ID, and then reading the
created CSV file.

(Note!) e Assignment of the Job Account ID is
only available for users that are added
from the Active Directory.

o If a Job Account ID is already assigned
to the user, the file contents are
overwritten.

@ Create a CSV file using software such as
Notepad or Excel etc.

<For Notepad>

@ write 1 login name on each line.

® Save in text format with the extension
"CSV".

<For Excel>

@D Write 1 login name on each line.
@ Save in CSV file format.

@® Check the [Only display non-assigned
login name] check box.
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® Click [File]. ® Click [OK].
@ Specify the CSV file created in @, and (Nme!) These settings are not reflected in
click [Open]. the printer until [Apply] in the [User

@ Check that the Job Account ID is
displayed in [User].
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Changing the assigned Job @ Select the user whose Job Account ID is
Account ID to be changed in [User].

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

® Click [Assign] in the [Login name/Group
name which synchronizes with Active
Directory] window.

@® Change the entry in [Job Account ID],
and click [Change].

)

® Uncheck the [Only display non-assigned
login name] check box.
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@ Click [OK]. Exporting data for client
software

Users added from Active Directory can be
used in the client software hidden mode.
For details on the client software hidden
mode, see "Setting the Job Account Mode"
(page 38).

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

(Note!) These settings are not reflected in
the printer until [Apply] in the [User
Registration on Active Directory]
window that appears after step @ is
clicked.

® Click [Export Users].

-

O Check the [For Client reference] check
box, and click [Browse].
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@ Select the folder that you want to save,
and click [OK].

@® Click [OK] in the [Export Users] window.

@ A file named opjobac4.dat is generated
in the folder selected in @, and the
generated file can be specified in the
[Hidden mode] of the client software.
For details on specifying the export file
for the client software, see "Acquiring
user information from files in hide mode"
(page 215).

Exporting the IC card
compatibility table

The IC card compatibility table associates
three types of data, namely the IC card
information (card ID), Job Account ID, and
login name. When the IC card compatibility
table is registered to the printer, the use
restrictions assigned to the Job Account

ID or login name can be applied to the IC
card authentication print job. In order to
register the IC card compatibility table with
the printer, all of the following conditions
need to be fulfilled.

e An SD card for receiving the IC card
compatibility table is installed in the
printer

e The printer power is ON

e The IC card compatibility table
registration settings in the printer
in which you want to register the IC
card compatibility table are enabled
(page 127)

e The settings for creating an IC card
compatibility table are enabled
(page 129)

Setting the printer to which
the 1C card compatibility
table is registered

Enable the IC card compatibility table
registration settings in the printer in
which you want to register the IC card
compatibility table.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.
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@ Select the printer, and then select the @ Check the [Download enrolled card table
[Printer] menu > [Properties]. to a printer] check box.

Multiple printers can be selected.

® Click [OK].

@ Click the [Option] tab > [Detail setting].

Printer' Uzer  Option |

Acquire Logs
& |nterval
|7 Hour IU Mirutes
= Time
_ © Click the [Option] tab > [OK].
Lhange Time... |
Properties of printer from which logs are acquired ﬂll
Fees C841/0831/C822 j .
Printer | User  Option |
Define fees... |
Acquie Logs
i |pteryval
g 5 J—— I? Hour IU Minutes
Dperation at Log Ful Dielete old | -
I elete old logs J  Tine
Lhange Time... |
Auto Export Logs Do not automatically export A
| v = | Fees Ca1/C831/C822 =l
I | Becord logs in & database Define f
Define fees... |
Click [Detail zetting] to cooperate with
Active Directary.
DOperation at Log Full IDeIete old logs j
ok | wet |
Auta Export Logs IDo ot automatically export j
® Check the [Synchronize user list with El Bissrlisasin b
Active Directory] check box. e [l e A Detai seting..._ |

Lyl
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@ If the settings for creating an IC card Creating the IC card

compatibility table are not set, a message TIT
notifying that the IC card compatibility compatlblllty table

table cannot be registered to the printer The IC card compatibility table is created
is displayed. Click [OK]. In order to based on Active Directory user information
register an IC card compatibility table that has already been registered.

to the printer, the settings for creating
an IC card compatibility table need

to be configured. For details on the @® Click [Policy] menu > [User Registration
settings required for creating an IC card on Active Directory].

compatibility table, see "Creating an IC
card compatibility table" (page 129).

@ Start the server software.

® When the window notifying the changed
setting items is displayed, click [Yes].

® Click [Export Users].

® When the window notifying that
the setting changes are complete is [:
displayed, click [Close].
@ Check the [Create card table] check box,

® When the [Login name/Group name ]
and click [Browse].

which synchronizes with Active Directory]
is displayed, configure the Active
Directory settings. For details, see the
100 page.

)

@ Select the folder that you want to save,
and click [OK].
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@ Click [OK] in the [Export Users] window. Adding IC card information
to the IC card compatibility
table

The following methods can be used to add
IC card information (card ID) to the IC
card compatibility table.

e Obtain from the Active Directory

— The IC card information obtained when a user
is added to the Active Directory can be added
to the IC card compatibility table. For details
on obtaining IC card information from the
Active Directory, see "Specifying attributes for
obtaining IC card information" (page 107).

e Using the Card Enroll Tool

@ When a window inquiring whether or not — When using the Card Enroll Tool, the IC card
to send the IC card compatibility table reader attached to the computer in which the
to the printer is displayed, click [Yes] to server software is installed is used to read
send the table, or [No] not to send the data from an IC card, which is then added to
table. the IC card compatibility table. The IC card ID
When [Create card table] is checked, the can also be added manually. Follow the steps
IC card compatibility table is updated below to use the Card Enroll Tool.
when Active Directory users are added, @ Install the Card Enroll Tool on the same

deleted, or when settings are changed. computer in which the server software is

installed.

® To enter the IC card ID manually, proceed
to step @. To enter the IC card ID from
the IC card, attach an IC card reader
to the computer in which the server
software is installed.

® Start the server software.

O Click [Policy] menu > [User Registration
on Active Directory].
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@ Click [Export Users]. ©® The Card Enroll Tool starts. The record list
of the IC card compatibility table created

by the server software is displayed in the

window.

)

@® Check the [Create card table] check box,
and click [Browse].

@ To add an IC card ID manually, double-
click the IC card ID field so the ID can be
entered. In this state, enter the IC card
ID using the keyboard.

When entering the IC card ID from the
@ Select the folder that you want to save, IC card, check the IC card ID recorder

and click [OK]. check mark, and place the IC card over

@ Click [Edit card table]. the IC C&?I‘d reader. Thg IC card ID is
automatically entered into the checked
recorder.
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® Click [Send].

)

® When the window confirming whether to
send the IC card compatibility table is

displayed, click [YES].

® The updated IC card compatibility table is
saved, and the IC card compatibility table

is registered t o the printer.

(Note!) The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility

table registration settings, see

"Setting the printer to which the IC
card compatibility table is registered"

(page 127).

The Card Enroll Tool can be installed in
a different computer to that in which
the server software is installed, and the
IC card ID can be added to the IC card
compatibility table created by the server

software.

For details on adding IC card IDs to the
IC card compatibility table created with
the server software from a Card Enroll
Tool installed on a different computer,
see the User's Manual from the IC card

authentication kit.

When adding IC card IDs to the IC card
compatibility table created with the
server software from a Card Enroll Tool
installed on a different computer, the
following settings are required on the
computer in which the server software

is installed.
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(@ Set the folder in which the IC card
compatibility table exists as a shared

folder, and set the access permissions
to allow changes from the computer
on which Card Enroll Tool is installed.

® Check that the [Remote Registry]
service is started. When the [Remote

Registry] service is started, the [Con-
trol Panel] > [Administrative Tools]>
[Services] > [Remote Registry] sta-
tus is displayed as [Started]. If it is
not displayed as [Started], [Start] is
displayed on the left side. Click it to
start the [Remote Registry] service.
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Registering the IC card
compatibility table to the
printer

The created IC card compatibility table can
be manually registered to the printer.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

® Click [Export Users].

)

@ Check the [Create card table] check box,
and click [Browse].

@ Select the folder that you want to save,
and click [OK].

@® Click [Send card table].

@ When the window confirming whether to
register the IC card compatibility table is
displayed, click [YES].

® When the window notifying that sending
is completed is displayed, click [Close].

When automatically updating registered
Active Directory users, the updated IC
card compatibility table is automatically
registered in the printer. For details

on automatically updating registered
Active Directory users, see “Setting the
automatic update service” (page 137).

(Note!) The IC card compatibility table cannot
be registered to a printer whose IC
card compatibility table registration
settings are not enabled. For details on
how to enable the IC card compatibility
table registration settings, see
"Setting the printer to which the IC
card compatibility table is registered"
(page 127).
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Displaying error messages at @ Click [OK].
server software startup

If the IC card compatibility table cannot be
registered to the printer, an error message
can be displayed at server software startup
to notify you of the error.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

® Click [Export Users].

J

O Check the [Display a message at startup
of this utility] check box.
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Sending an error notification @ Click [OK].
mail to the administrator

If the IC card compatibility table cannot
be registered to the printer, a mail that
contains the error details can be sent once
a day to the administrator.

@ Start the server software.

@® Click [Policy] menu > [User Registration
on Active Directory].

(Note!) The outgoing mail server, sender's

® Click [Export Users]. e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).

)

® Check the [Notify administrator by
e-mail] check box.
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Permitting alternative
authentication to IC cards

The settings for the IC card alternative
authentication mode of the printer can be
configured.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

@ Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ Click the [Option] tab > [Detail setting].
21|

Printerl Uzer  Option |

Acquie Logs
& |nterval
I? Hour ID Mirtes
 Time
Lhange Time... |
Fees Cad41/0831/0822 j
Define fees... |
DOperation at Log Full IDeIete old logs j
Auta Export Logs IDo ot automatically export j
I™ | Becord logs in & database
Click [Detall setting] to cooperate with
Active Directory.

ok | set |

® Check the [Synchronize user list with
Active Directory] check box.

@ To enable the IC card alternative
authentication mode, check the [Allow
alternative authentication for card] check
box. To disable the IC card alternative
authentication mode, uncheck the [Allow
alternative authentication for card] check
box.
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© Click [OK].

© Click the [Option] tab > [OK].
Fropeti of prnte from v 21

Printer' Uzer  Option I

Acquire Logs
& |nterval
7 Hour ID Minutes
= Time
Lhange Time... |
Fees C841/0831/C822 j
Define fees |
Operation at Log Full IDeIete old lags j
Auta Expart Logs IDo hot automatically expart j
I | Becord logs in & database
Click [Detail zetting] to cooperate with Detail setting... |
Active Directory. E

Ty T ) |

® When the window notifying the changed
setting items is displayed, click [Yes].

® When the window notifying that
the setting changes are complete is
displayed, click [Close].

Setting the automatic
update service

The Active Directory user information can
be periodically monitored, and changes
to registered user or group information
can be updated. Monitoring in order to
automatically update registered users or
groups is set to enabled by default, but
settings such as the monitoring schedule
settings, and which users and groups are
target for monitoring can be changed.

(Note!) When a new user that belongs to a
group that is target for monitoring in
the Active Directory is added, users can
be registered to the printer until the
maximum number of users that can
be registered to the printer is reached.
After the maximum number of users
that can be registered is reached,
subsequent users are not registered to
the printer.

@ Start the server software.

@ Click [Policy] menu > [User Registration
on Active Directory].

@® Click [Setup].
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O Click [Set Up Refresh Service] in the @ Check the users/groups to monitor for

[Active Directory User/Group Settings]. updates on the Active Directory. When a
group is checked, the users that belong

to the group are also monitored.

@ Set the automatic update timing. ® Click [OK].

Specify Time

Automatic update can be performed at a set time.
This can be set in day units.

Specify Interval

The automatic update interval can be set in
minute units.

® Set the user/group to monitor for
updates.
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Immediately updating user
settings

Updates can be performed immediately as
well as those performed at the automatic
update timing set in the [Set Up Refresh
Service] window.

@ Start the server software.

@® Click [Policy] menu > [User Registration
on Active Directory].

® Click [Setup].

@ Click [Refresh Now] in [Active Directory
User/Group Settings].

Selecting the users to
apply settings to
Click [Apply] in the [Login name/Group
name which synchronizes with Active

Directory] window and the users/groups to
registered to the printer can be selected.

@ Select the printer from the printer list
in the [Login name/Group name which
synchronizes with Active Directory]
window.

® Click [Select user].
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® Check the users/groups to register in
the printer in the [Select user which is
registered] window.

O Click [OK].

NoteD Users that belong to groups are not
displayed in the [Select user which is
registered] window.
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7. Saving managed data to the database

7. Saving managed data to the database

This section explains how to export the log, Job Account ID, and fee charge definition to
the database, and how to browse the log, Job Account ID, and fee charge definition from a
web browser. The log can be exported to the database from the point at which it is obtained
from the printer. The Job Account ID can be exported to the database at the point when it
is registered to or deleted form the printer, or when the settings are changed. To export the
managed information to the database, the following settings need to be configured.

e Database software settings (page 132)

e Settings for connecting to the database (page 143)

In order to export the managed log and Job Account ID information to the database, the
following settings also need to be configured in addition to the settings listed above.

e Settings for recording information to the database of the printer that you want to export
managed information to must be enabled (page 144)

Configuring the database
software settings

Connecting using Microsoft
SQL Server or Microsoft SQL
Server Express

When the server software is installed

in the Windows 2000 operating system

and connects to Microsoft SQL Server

or Microsoft SQL Server Express, it is
necessary to install version 2.7 or higher of
MDAC (Microsoft Data Access Components)
to the Windows 2000 operating system.
MDAC can be downloaded from the
Microsoft website.

Connecting to MySQL
Database

When using MySQL on a different computer
to that which contains the server software,
libmysql.dll needs to exist in the server
software installation folder.

@ Copy libmysql.dll from the "bin" folder or
"lib" folder of the installation folder of the
MySQL installation to be used

@® Paste the file into the installation folder of
the server software.
Depending on the MySQL version, the
administrator "root" permissions may not
be sufficient. In this case, increase the
permission level.

@ Start [MySQL Server Instance Config
Wizard] and check the [Include Bin
Directory in Windows PATH] check box to
complete the settings.

@ Start the command prompt in Windows
0Os.

® Execute the following command.
Mysql —u root —p

O Enter the administrator "root" password
that was set when MySQL was installed.

@ Execute the following command.
grant all privileges on *.* to 'root'@'%'
with grant option;
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Settings for connecting to
the database

@ Start the server software.

@® Click the [Option] menu > [Setup].

® Display the [Database] tab.

@ Check the [Record logs in database]
check box.

)

(Note!) If [Record logs in database] is disabled,
it is not possible to connect to the
database.

@ Configure the settings for the database to
connect to.

Database

Select the type of database to connect to. The
types of database that can be selected are
Microsoft SQL Server, Microsoft SQL Server
Express Edition, Microsoft Access and MySQL.

Authentication
Select the authentication method used when
connecting to the database.
Windows authentication
Authenticated connection using the Windows
user permission registered in the database.

This can only be selected in Microsoft SQL
Server or Microsoft SQL Server Express Edition.

User authentication

Authenticated connection using the user
permission for User authentication registered in
the database.

Access

Specify whether the connected database is a
location connection or network connection.
Local database
Connect to a database that exists on this
computer.
Network database

Connect to a database that exists on a different
computer on this network.

Server Name

Specify the IP address or computer name of
the computer on which the database exists. A
maximum of 270 can be entered.

Path Name

Specify the path name where the database to
connect to exists. A maximum of 270 can be
entered. This can only be entered when Microsoft
Access is used.
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User Name

Specify the user name of the database to
connect to. A maximum of 80 can be entered.
When Windows authentication is selected for

[Authentication], specify a valid Windows account

that can connect to the database using Windows
authentication from the obtain log service. For
example, the computer administrator.

Password

Specify the password of the database to
connect to. A maximum of 80 can be entered.
When Windows authentication is selected for
[Authentication], specify the password for the
Windows account name.

@® Click [OK]. Connect to the set database,
and the settings are complete when the
connection is successfully established.

Setting the printer for
recording managed data
to the database

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

@ Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
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@ Check the [Option] tab > [Record logs in ©@ When the window notifying the changed
a database] check box. setting items is displayed, click [Yes].
2]

Printer | User  Option |

Acquire Logs

& |nterval

0 Hour IW Minutes
Lhange Time... |

Fees C841/0831/C822 j

Define fees... |

" Time

DOperation at Lag Full IDeIete old logs j

Auto Export Logs IDo not automatically export j

" ' i Dretail setting...
Active Directory. —gl

® A window inquiring whether or not to
export the database to the Job Account
x| 58| ID registered in the printer is displayed.
Click [YES] to immediately export the
(woter) If the settings for connecting to database. Click [NO] to not export the
a database (page 143) are not database.
implemented, [Record logs in a
database] is grayed out.

©® When the window notifying that
the setting changes are complete is

® Click [OK]. displayed, click [Close].

Properties of printer from which logs are acquired 2x|

Printer' Uzer  Option |

Acquire Logs
& |nterval
0 How |17 Minutes
= Time

Lhange Time... |

Fees C841/0831/C822 j

Diefine fees... |

Operation at Log Full IDeIete old lags j

Auta Expart Logs IDo not automatically expart j

¥ Becord logs in a databaze

Click [Detail zetting] to cooperate with Detail setting... |
Active Directary. =

e T Fa—
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Exporting the fees to the
database

The managed fee definitions are exported
to the database.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

@ Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@® Click [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is
displayed.
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@ Select the fee charges from [Fee], and
click [Add].

(Note!) ¢ Fees that already exist in the database
are overwritten.

¢ Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.

Deleting fees from the
database

Delete the fee definitions from the
database.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.
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@O Check the [Record logs in database] @ Select the fee charges from [Database's
check box. fees], and click [Delete].

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@® Click [Fee]. Connect to the set database,
and when the connection is successfully
established the fee export window is
displayed.
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Exporting the |og to the O Select the log to export, and select the
[Log] menu > [Export logs into the
database database].

The obtained log is written to the
database. In order to change the log items
written to the database, see "Changing the
log items to be exported" (page 208).

@ Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window. The log
tree opens.

(Note!) ¢ Single quotation marks that exist in
the character string are replaced with
space characters, and the information
is saved in the database.

e Logs of printers whose database
recording settings are disabled are
® Using the same operation as step 2, open not exported. For details on enabling

the tree for [Printer] or [Date]. the database recording settings, see
"Setting the printer for recording
managed data to the database"
(page 144).
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De|eting |ogs from the O Select the log that you want to delete
from [List of logged months and years].
database

Delete a log from the database.
@ Start the server software.

@ Click the [Log] menu > [Delete logs from
the database].

@ Click [Delete].

® Display the database logs using either
the [By printer] or [By month and year]
method.

By printer

Just the logged month and year of the printer
selected in [List of printers being logged] are
drawn from the database and displayed.

By month and year

Just the logged months and years selected in
[List of database-logged months and years] are
drawn from the database and displayed.
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Exporting the printer O Check the [Record logs in database]
check box.
users to the database

The managed Job Account IDs are E

exported to the database.
@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@ Click [Printer User].
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@ When connection to the set database Registering database
is successfully established, a message .
confirming whether or not to export connection users
the Job Account ID to the database is Register database connection users.
displayed. Click [YES].
@ Start the server software.
(Note!) ¢ Job Account IDs that already exist in
the database are overwritten. @ Click the [Option] menu > [Setup].
e Job Account IDs of printers whose
database recording settings are
disabled are not exported. For details
on enabling the database recording
settings, see "Setting the printer
for recording managed data to the
database" (page 144).
¢ Single quotation marks that exist in ® Display the [Database] tab.
the character string are replaced with
space characters, and the information D
is saved in the database.
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® Check the [Record logs in database]
check box.

]

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@ Click [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

@ Click [Add].

® Specify the [User Name],
[Authentication], [Password], [Repeat
Password] and permissions, and click
[Add].

(Note!) If the users and user names duplicate
those that are already registered in the
database, they cannot be added.
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© Click [OK]. Changing the permissions
for database connection
users

Change the permissions for registered
database connection users.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

@® When the registration results notification D
V4 window is displayed, click [Close].

(Note!) Users registered to a Microsoft Access
database only use authentication to
browse the database from a website.
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@O Check the [Record logs in database] @ Select the users whose permissions you
check box. want to change in [List of users], and

click [Change Privileges].

® Select the permissions, and click [OK].

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@ Click [Database user registration]. © When the permission change results
When connection to the set database notification window is displayed, click
is successfully established, the [Regist [Close].
user to connect with database] window is
displayed.
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Changing the password
for database connection
users

Change the password for registered
database connection users.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

.

@O Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@® Click [Database user registration].
When connection to the set database is
successfully established, the [Register
user to connect with database] window is
displayed.
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@ Select the users whose permissions you
want to change in [List of users], and
click [Change Password].

® Enter the [Password] and [Repeat
Password], and click [OK].

Deleting database
connection users

Delete registered database connection
users.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.
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@O Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@ Click [Database user registration].
When connection to the set database
is successfully established, the [Regist
user to connect with database] window is
displayed.

@ Select the users whose permissions you
want to delete in [List of users], and click
[Delete].

® When a window confirming whether or
not to delete the user is displayed, click
[YES].
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Updating the database to O Check the [Record logs in database]
. check box.
the newest version

If a new format of database can be used E

due to an update to the server software,
the database format can be updated to the
newest version. Data that already exists in
the database is retained.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

)

@ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 143).

@® Click [Update the database table]. When
the connection to the set database
is successfully established, a window
inquiring whether or not to update
the database to the newest version is
displayed. Click [YES].
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Displaying error messages
at server software startup

A message can be displayed at startup if
additions to the log database fail.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

J

@ Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 143).

@® Check the [Display a message at startup
of this utility] check box, and click [OK].
When connection to the set database is
successfully established, the settings are
saved.
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Sending an error
notification mail to the
administrator

If additions to the log database fail, a mail
that contains the error details can be sent
once a day to the administrator.

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

)

@O Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 143).

@® Check the [Notify administrator by
e-mail] check box. When connection
to the set database is successfully
established, the settings are saved.

)

(Note!) The outgoing mail server, sender's
e-mail address, and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).
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Creating a website
[Microsoft Windows 7]

This section explains how to create a
website when Microsoft Windows 7 is used
as the software.

Installing the internet
information service

In order to create a website, internet
information service needs to be installed in
the computer.

@ Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].

@® Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.

® Check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

O Check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

® Click [OK].
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Configure settings for © Display the [Database] tab.
browsing a Microsoft Access D
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

(System drive) Windows\temp\

Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the

) @O Check the [Record logs in database]
MySQL website.

check box.
Checking the version of
Microsoft SQL Server or E
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website

@ Start the server software.

@® Click the [Option] menu > [Setup].
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@ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for
connecting to the database" (page 143).

® Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].

©®@ When the connection is established
successfully to the set database, the
[Selection of Web site] window is
displayed. Select the website, and click
[OK].

Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

@ Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

® When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note!) Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method

@ Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Windows Authentication].
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Creating a website
[Microsoft Windows
Server 2008]

This section explains how to create a
website when Microsoft Windows Server
2008 is used as the software.

Installing the internet
information service

In order to create a website, internet
information service needs to be installed in
the computer.

@ Select [Administrative Tools] > [Server
Manager], and select [roles] > [Add
roles].

@® Select [Web Server (1IS)], and check all
of the [Administrative Tools] and [IIS 6
Management Compatibility] items.

® Select [Web Server (IIS)], and check all
of the [ASP] and [ISASP Extension] items
in [Administrative Tools] and [Application
Development Features] items.

@ Select [Web Server (1IIS)], and check the
[Security] and [Windows Authentication]
check boxes.

@ Click [Install].

Configure settings for
browsing a Microsoft Access
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

(System drive) Windows\temp\

Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.

Creating a website

@ Start the server software.

@ Click the [Option] menu > [Setup].

® Display the [Database] tab.

—J
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@O Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

® Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].

@ When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

Setting the website

Configure the settings for accessing the
created website from a web browser on the
computer.

The setting methods differ between when
the Windows authentication method is
used from the web browser, or the User
authentication method is used to access
the website.

Accessing using the Windows
authentication method

@ Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

® When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note!) Be careful when checking [Anonymous
Authentication], as any user can browse
the database.
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Accessing using the User Creating a website
authentication method [Microsoft Windows Vista]
@ Select [Control Panel] > [Administrative This section exp!ains how _tO create.a _
Tools], and select [Internet Information website when Microsoft Windows Vista is
Service (IIS) Manager]. used as the software.
® When the window is displayed, select Installing the internet
the [JALogDB] website, and click . . .
[Authentication]. information service

In order to create a website, internet
information service needs to be installed in
the computer.

® Disable [Windows Authentication].

@ Select [Control Panel] > [Program and
Features], and select [Turn Windows
features on or off].

@® Check all of the items in [Internet
Information Services] > [Web
Management Tools] > [IIS 6 Management
Compatibility], and check the [IIS 6
Management Console] check box.

® Check the [ASP] and [ISASP Extensions]
in [Internet Information Services] >
[World Wide Web Service] > [Application
Development Features].

- 167 -



7. Saving managed data to the database

® Check [Windows Authentication] in
[Internet Information Services] > [World
Wide Web Service] > [Security].

® Click [OK].

Configure settings for
browsing a Microsoft Access
database

In order to browse a Microsoft Access
database from a website, "Authenticated
Users" need to be added to the
[Properties] and [Security] tab in the
following folder, and the "Authenticated
Users" permissions need to be raised to full
control.

Window Vista

Select [Control Panel] > [Folder Options] >
[View] tab, and when the [Show hidden files,
folders and drives] check box is checked in the
detailed settings, the following folder is displayed.
(System drive) Windows\ServiceProfiles\
NetworkService\AppData\Local\

Window Vista SP1 and subsequent
versions

(System drive) Windows\temp\

Configure settings for
browsing a MySQL database

To browse a MySQL database from a
browser, MySQL Connector/ODBC 5.1
needs to be installed. MySQL Connector/
ODBC 5.1 can be downloaded from the
MySQL website.

Checking the version of
Microsoft SQL Server or
Microsoft SQL Server Express

To browse a Microsoft SQL Server database
or Microsoft SQL Server Express Edition
database from a website, the database
version needs to be Microsoft SQL Server
2005 Service Pack 2 or higher, or Microsoft
SQL Server 2005 Express Edition Service
Pack 2 or higher.
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Creating a website

@ Start the server software.

@® Click the [Option] menu > [Setup].

® Display the [Database] tab.

@O Check the [Record logs in database]
check box.

)

@ Configure the settings for the database to
connect to.
For details on the settings of the
connected database, see "Settings for
connecting to the database" (page 143).

@® Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
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@ When the connection is established
successfully to the set database, the

website selection window is displayed.

Select the website, and click [OK].

Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

@ Select [Control Panel] > [Administrative
Tools], and open [Internet Information
Service (IIS) Manager].

® When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Anonymous Authentication], and
enable [Windows Authentication].

(Note! Be careful when checking [Anonymous
Authentication], as any user can browse
the database.

Accessing using the User
authentication method

@ Select [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® When the window is displayed, select
the [JALogDB] website, and click
[Authentication].

® Disable [Windows Authentication].
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Creating a website @ Check the [Record logs in database]
[Microsoft Windows check box.
server 2008, XP, 20001 —

This section explains how to create a
website when Microsoft Windows Server
2003, XP, or 2000 is used as the software.
In order to create a website, internet
information service needs to be installed in
the computer.

Creating a website

@ Start the server software.

@® Click the [Option] menu > [Setup].

@ Configure the settings for the database to
connect to. For details on the settings of
the connected database, see "Settings for

Displ he [D .
© Display the [Database] tab connecting to the database" (page 143).

@® Check the [Accessing database from
website] check box, enter the [Title
displayed on website], and click [OK].
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@ When the connection is established
successfully to the set database, the
website selection window is displayed.
Select the website, and click [OK].

Setting the website

Configure the settings for accessing the
created website from a web browser on
the computer. The setting methods differ
between when the Windows authentication
method is used from the web browser, or
the User authentication method is used to
access the website.

Accessing using the Windows
authentication method

@ Seclect [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® When the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].

® When the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.

® When the window is displayed, uncheck
the [Anonymous access] check box, and
check the [Windows Comprehensive
authentication] check box.

(NOte!) Be careful when checking [Anonymous
access], as any user can browse the
database.

Accessing using the User
authentication method

@ Seclect [Control Panel] > [Administrative
Tools], and select [Internet Information
Service (IIS) Manager].

® When the window is displayed, select the
[JALogDB] website, right-click, and click
[Properties].

® When the [Directory Security] tab is
displayed, click [Anonymous access and
authentication control] > [Edit] button.

® When the window is displayed,
uncheck the [Windows Comprehensive
authentication] check box.

Browsing the database from
the website

@ Connect to the website URL from a web
browser. The following methods can be
used to specify the URL.

When the server software is installed on

the computer
http://localhost/JALogDB/

When the server software is installed on

a different computer
http://(Computer IP address)/
JALogDB

® When the website is displayed, select
the authentication method. The following
authentication methods are available.

Window Auth

This is the Windows authentication method. This
can be used when connecting to Microsoft SQL
Server or Microsoft SQL Server Express Edition.
When [Window Auth] is selected, the PC in which
the server software is installed and PC in which
the database is installed need to be registered to
the same domain.

User Login

This method authenticates users that are
registered in the database. Enter the [Account]
and [Password].
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® Click the [Login] button.

@ The display window of the log registered
in the database is displayed. The
following operations can be performed in
the log display window.

Displaying a specific printer log

When the printer name (IP address) is clicked in
the [Printer] section of the selection window, the
log of the printer whose IP address is selected in
the details window is displayed.

Displaying a log from a specific obtain
date
When the date is clicked in the [Date] section

of the selection window, the log from the obtain
date selected in the details window is displayed.

Aggregating displayed logs by printer

Click [Printer] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the printer.

Aggregating displayed logs by Job
Account IDs
Click [User ID] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the Job Account IDs.

Aggregating displayed logs by user name

Click [User name] in the [Export by] section of
the detail window, and the displayed logs are
aggregated according to the user name.

Aggregating displayed logs by date

Click [Date] in the [Export by] section of the
detail window, and the displayed logs are
aggregated according to the date.

Displaying user information

When [User information] is clicked in the
selection window, the user information recorded
in the database is displayed.

Displaying fee information

When [Cost information] is clicked in the
selection window, the fee information recorded in
the database is displayed.
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8. Fees

8. Fees

Fees are used to request cost burdens from the user according to the status of use.
In the Print Job Accouting, fees can be defined in fine detail, such as the number of prints,

print paper size, and length of possession.

(Note!) The window and setting contents differ depending on the printer model.

Creating fee charge
definitions

Creating a definition

@ Start the server software.

@® Select [Printer] menu > [Define Fees].

© Click [Add].

The initial settings definition shows

a rough guide to the running costs
calculated from the standard prices of
various consumables and the number of
prints over the lifetime for each model.

@ Enter the name of the definition to be
created in [Name].

@ Click the tabs of the items that you want
to set, and configure the settings.

Page tab

The fees for one print based on the the total
number of prints and print pages can be set. In
the print pages, color printing and monochrome
printing can be set separately.

@ Check [Page], and then enter the fees
for [Color] and [Mono].

@ Check [Sheet], and enter the fees.
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Toner use amount tab

Set to apply fees for the amount of toner used.
To apply fees for the amount of toner used, check
the [Toner use amount] check box, and set the
fee charges for the amount of toner used at each
level per page.

To set the fee charges per page for each level,
select the level that you want to set from the list,
click the [Change] button, enter the fee charge
per page in the [Color Fee] field and [Mono Fee]
field in the cost change window, and click [OK].
To automatically calculate the fee charges, select
the printer in which automatic calculation will

be used from [A printer used for fee automatic
calculation], and enter the color toner price in the
[Color Price] field and monochrome toner price in
the [Mono Price] field. When there are two types
of toner and the large capacity type of toner is
used, check the [Large Capacity] check box and
click [Automatic calculation].

According to the type of printer, the [Setting
life] check box is displayed instead of the [Large
Capacity] check box. To set the toner lifespan
and automatically calculate the cost, check the
[Setting life] check box, and enter [Color life] and
[Mono life]. When [Setting life] is not checked,
the [Do you want to acquire the information

of the toner installed in the printer?] message

is displayed. Check that the printer power is
ON, and click [Yes]. When [No] is clicked or if
information cannot be obtained from the printer,
toner information from when the printer was
registered is used for the automatic calculation.
When large capacity and standard toners are
mixed, calculations are based on the large
capacity toners.

For details on the toner usage level, see [Items
that can be aggregated] - [Toner].
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Drum use amount tab

Set to apply fees for the amount of drum used.
To apply fees for the amount of drum use, check
[Drum use amount], and enter fees for color
drum use per 1 A4 size page in the [Color Fee]
field, and enter fees for the monochrome drum
use per 1 A4 size page in the [Mono Fee] field.
To automatically calculate the fees, select the
printer to use from [A printer used for fee
automatic calculation], enter the color drum
price in the [Color Price] field and monochrome
drum (or 4-color combined unit drum) price

in the [Mono Price] field, and click [Automatic
calculation]. For 4 color combined unit drum, the
[Color Fee] and [Color Price] fields cannot be
entered.

Belt, fuser use amount tab

Set to apply fees for the amount of belt and fuser
used.

To apply fees for the amount of belt and fuser
use, check [Belt, fuser use amount], and enter
fees for belt use per 1 A4 size page in the [Belt
Fee] field, and enter fees for the fuser use per
page in the [Fuser Fee] field.

To automatically calculate the fees, select the
printer to use from [A printer used for fee
automatic calculation], enter the belt price in the
[Belt Price] field and fuser price in the [Fuser
Price] field, and click [Automatic calculation].
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Finisher tab Size tab

Fees can be set for 1 page of each paper size.
Fees can also be applied just to specific sizes.

When the optional finisher is installed, set the fee
for each time that the stapler is used.

@ Check [Staple], and enter the fees. \

)

@ Check [Size], and click [Change].

@ In the [Detailed setting for fees]
window, select the size to apply fees to
from [Size], and enter the fee charges.

® Click [Add].

@ Repeat steps @ and @, and add the
sizes that require fees.

® When all required sizes are added,
click [OK].

(Note!) A4, B5, letter, 16K 184x260mm, 16K
195x270mm and 16K 197x273mm are
different paper sizes with longitudinal
feed and cross feed. When cross
feed is used, add A4 horizontal,

B5 horizontal, A5 horizontal, letter
horizontal, 16K 184x260mm horizontal,
16K 195x270mm horizontal, and 16K
197x273mm horizontal.
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Tray tab Media Type tab
Fees can be set for 1 page from each used tray. Fees can be set for 1 type of each paper size.
Fees can also be applied just to specific trays. Fees can also be applied just to specific paper
types.

- O

@ Check [Tray], and click [Change].

. . @® Check [Media], and click [Change].
@ In the [Detailed setting for fees]

window, select the tray to apply fees @ In the [Detailed setting for fees]
to from [Tray], and enter the fee window, select the paper type to apply
charges. fees to from [Media type], and enter
the fee charges.
® Click [Add].
® Click [Add].

@ Repeat steps @ and ®, and add the
trays that require fees. @ Repeat steps @ and @, and add the

_ _ paper types that require fees.
® When all required sizes are added,

click [OK]. ® When all required sizes are added,
click [OK].

® Click [OK].
@ Click [End].
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Setting printer fee definitions | O Select the fee charges definition to be
used from the [Option] tab > [Fees], and

@ Start the server software. click [OK].

@® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details

window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
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Changing fee charge
definitions
@ Start the server software.

@® Select [Printer] menu > [Define Fees].

@ Select the definition name that you want
to change, and click [Properties].

® Change the settings in the [Define Fees]
window, and click [OK].

For details on the setting items, see
"Creating fee charge definitions"
(page 176).

When the name is changed, it is
registered as a new definition. The
previous settings remain under the
former definition name.

@ Click [End].

Deleting fee charge
definitions

(Note!) e Initial setting definitions cannot be
deleted.

¢ When the definition set in the current
printer is deleted, it is replaced with
the initial settings definition.

@ Start the server software.
@® Select [Printer] menu > [Define Fees].

® Select the definition name that you want
to delete, and click [Delete].

@ Click [End].
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9. Operating the Log

This section explains settings for acquiring the log, and operations such as displaying or
deleting the log.

What is the Log?

In Print Job Accouting, various information about print jobs such as who, when, and which
printer was used for print jobs is stored on the printer built-in hard disk or flash memory. This
information is called the log. The server software acquires the log from the printer according
to a set schedule.

By logging this information, it is possible to check how much individuals are printing, and how
much a specific printer is being used.

(Note!) ¢ A log entry is made when one or more sheets are printed. Furthermore, log entries are
made when printing is rejected, or when a job is cancelled because color printing is rejected.

e However, log entries are not made when the printer power is turned OFF during processing
or printing, or if printing cannot be performed because the printer has an error.

Acquiring the Log

Information that can be acquired

Information that can be acquired as a log is as shown below.

(Note!) The information that can be acquired differs depending on the printer model or whether
options are used.

Item Details

Printer The printer name and connection destination
displayed in the log. This is displayed when all printer
logs are displayed.

Date The date of the displayed log. This is displayed when
logs from all dates are displayed.

Log No. The log number. Assigned for each month starting
from 1.

Job Account ID The Job Account ID set in the client computer that

executed the printing job, or the PIN ID entered into
the control panel.

User User name set in the client computer that executed
the printing job.

Login Name Login name of the client computer that executed the
print job.

Document Name Name of the printed document. If the document

name contains a " symbol, the " symbol is replaced
with a one-byte space. In some cases, the correct
document name cannot be acquired.

Application Name of the application used to execute the print
job.
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Item Details

Fees Fees incurred for the print job.

Host Name Name of the client computer that executed the print
job.

Port Name of the port used for printing. When using over
a network, the IP address of the client computer is
displayed.

Total Sheets Number of sheets printed.

Pages Number of pages printed. When duplex printing

is used, one sheet is counted as two pages. This
number is the actual number of printed pages as
opposed to the document page number. For example,
when a 6 page document is printed using 2-UP
printing, the number of pages is 3 pages.

Status The job processing result.

e Completed: Job completed normally.

e Canceled: Job cancelled by user operation. (For
printing, when one or more sheets are printed)

e Aborted: Job cancelled by a reason other than the
user operation.

e Abnormal Completed: Job completed abnormally.

Detailed Status ¢ Log Buffer Full:
Job cancelled because the printer log buffer is full.

e Access Control: Job cancelled by use restrictions.
e Memory Over Flow:
Job cancelled by memory overflow.
e Color Control:
Job cancelled by use restriction (Disable Color
Printing).
e Mono Printing (Color limited):
Job printed in monochrome due to use restriction
(Disable Color Printing).
eLip Error:
Job cancelled by lip error.

Paper Size Size of the printed paper. If a there are multiple
paper sizes used in the same print job, this item is
displayed over a number of lines.

Media Type "= Type of the printed paper. If a there are multiple
paper types used in the same print job, this item is
displayed over a number of lines.

Media Weight 1+~ Thickness of the printed paper. If a there are multiple
paper thicknesses used in the same print job, this
item is displayed over a number of lines.

Duplex This distinguishes between single-sided or duplex
printing. If both single-sided and duplex printing used
in the same print job, this item is displayed over a
number of lines.
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Item Details

Sheets " When one print job is displayed over a humber of
lines, the number of printed sheets is displayed on
each line.

Color = Number of color pages printed. When one print job
is displayed over a number of lines, the number of
pages is displayed on each line.

Mono * Number of monochrome pages printed. When one
print job is displayed over a number of lines, the
number of pages is displayed on each line.

N-up Displays how many pages of data are reduced and
printed within the printing range of 1 page.

Toner The level of toner (toner usage density for each A4
size page) used for each color is displayed as one of
the following 6 levels, from O to 5.

Level Density of the amount of
toner used

0 0%

1 ~5%

2 ~15%

3 ~30%

4 ~60%

5 61%~

Drum Amount of drum used for each color (converted to
amount of drum used for each A4 size page). The
amount of drum use of a 4-in-1 color drum unit is
displayed is drum (K).

Belt Amount of belt used (converted to the amount of belt
used for each A4 size page)

Fuser Amount of fuser used (amount of fuser used for each
page)

Staple When the optional finisher is installed, this shows the
number of times the stapler is used.

Log Acquire Time *2 The time at which the server software acquired the
log.

Start Time 23 Time at which the printer received the job.

Process Start Time 273 Time at which the printer started processing.

Process End Time "2+ Time at which the printer ended processing.

Print Start Time 23 Time at which the printer started printing.

End Time =2+ Time at which the printer ended printing.

Processing Off-line Time =2 | The time during which printer processing stopped due
to an error such as a paper jam during processing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control
panel.
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Item Details

Printing Off-line Time * The time during which printer processing stopped
due to an error such as a paper jam during printing,
paper size error, or no paper, or the amount of time
(seconds) the printer is set to offline on the control

panel.

Trayl = Number of sheets supplied from tray 1.

Tray2 = Number of sheets supplied from tray 2.

Tray3 = Number of sheets supplied from tray 3.

Tray4 =2 Number of sheets supplied from tray 4.

Tray5 = Number of sheets supplied from tray 5.

Multi-purpose Tray *2 Number of sheets supplied from the multi-purpose
tray/manual feeding tray.

Multi-purpose Feeder =2 Number of sheets supplied from the optional multi-
purpose feeder.

300dpi Number of pages printed at 300dpi.

600dpi 2 Number of pages printed at 600dpi.

1200x600dpi = Number of pages printed at 1200 x 600dpi.

1200dpi = Number of pages printed at 1200dpi.

2400x600dpi Number of pages printed at 2400 x 600dpi.

Color Scan Page Number of pages scanned in color.

Mono Scan Page Number of pages scanned in monochrome

Scan Page Print Status Indicates whether the scanned pages are printed.

e Scan Job Print:
Number of scan jobs that are accompanied with
printing.

e Scan Job No Print:
Number of scan jobs that are not accompanied with

printing.
Job ID Number used to identify the job. When multiple logs
are generated for the same job, the ID number is the
same.
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Item

Details

Function

¢ Print: Print job.
e Fax receive print: Fax receive print job.
e PC Scan: PC scan job.
e Push Scan: Push scan job.
e Scan to network PC:
Scan to network PC job.
e Scan to e-mail:
Scan to e-mail job.
e Fax send: Fax send job.
e Copy: Copy job.
e Scan to USB memory:
Scan to USB memory job.
e Scan to Internet Fax:
Scan to Internet fax job.
e Scan to Fax Server:
Scan to Fax Server job.
e Send Fax from PC: Send Fax from PC job.
¢ Printing from a saved Fax:
Printing job from a saved Fax.
e E-mail receive printing: Printing job for a received
e-mail.
e Printing from USB Memory: Printing job from USB
memory.
¢ Printing from Control Panel:
Printing job from the control panel.
e Other scans: Other scan jobs.

Service

Name of the service.
¢ Print: Print processing log.
e Scan: Scan processing log.
e Fax: Fax processing log.
¢ PC Scan: PC scan processing log.
e PC Fax: Fax send from PC processing log.
e E-mail: Receiving or sending e-mail processing log.
e Server:
Log of file save process to network PC.
e USB memory:
Log of file save process to USB memory.

Scan Page Size

Size of the scanned document.

Communication Time

Time required to send or receive a fax.

Destination

When the service is Fax or PC Fax, this is one of the
following: Telephone number of the Fax source or
destination, recipient ID, or equipment information.
If the service is a server, this is the file save
destination folder.

When the service is a USB memory, this is fixed as
USBMEMO1.

When the service is an e-mail, this is the e-mail
address of the sender or receiver.
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Item

Details

Communication Mode

This is the type of communication, Fax or e-mail.

e Send: Fax send job.

e Receive: Fax receive job.

e Send to multiple recipients: Fax send job to
multiple recipients.

e Send from PC: Fax send job from a PC.

¢ Send to multiple recipients from a PC:

Fax send job to multiple recipients from a PC.
e E-mail send: E-mail send job.
e Send e-mail to multiple recipients:

E-mail send job to multiple recipients.

Manual

Turns "ON" when a fax is transmitted manually.

Time Specified

Turns "ON" when the time is specified in a fax.

Polling Turns "ON" when polling transmission is used in a
fax.

F-Code Turns "ON" when F code transmission is used in a
fax.

Call/Receipt Call: Indicates when the receiver is called by fax.

Receipt: Indicates when a call is received from the
sender fax.

Fax Forwarding

Turns "ON" when a fax is forwarded.

Communication page

Number of pages sent or received by fax.

Service Code

Fax transmission error code.

*1 When multiple lines are displayed, items other than this main item are displayed as blank

spaces in the second and subsequent lines.
*2 This item is not displayed in the default settings.
*3 If the time is not notified to the printer, this remains blank.
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Changing the log acquisition
interval and time

The interval and time at which the server
software acquires the log can be changed.

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O 1n the [Option] tab, change [Acquire
Logs].

(Note!) Always set a time when the computer in
which the server software is set up and
printer power are both switched ON.
The log cannot be acquired if the power
is not ON.

Interval

Set the interval when the log is acquired over a
fixed time. The maximum interval time that can
be set is 24 hours. The default setting is set as
an optimized value detected from the state of
the printer. If the interval is set to a time that is
longer than the default settings, some of the logs
may not be acquired.

Time

Set the specific time. Click [Change Time], and
add the time to the [Change Time To Acquire
Logs] window. Up to 5 acquisition times can be
added. After adding, click [OK].

@ Click [OK].
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Changing the deadline

The deadline date on which the log is collected can be set.

The log contents up to the set deadline date are counted for the month.

E.g) If the deadline is set for the 15th, the contents from the 16th of the previous month to
the 15th of this month are collected in the log.

O

1715 For February 2/15 For March 3/15

I — I

When [Count logs after the closing dates as logs for this month] is checked, the logs for the

day after the set deadline are counted in the current month.

E.g) When the deadline is set for the 15th and [Count logs after the closing dates as logs for
this month] is checked, logs from the 16th of this month to the 15th of the following
month are collected in the log for this month.

1/|15 For January 2715 For February 3/15

@ Select [Option] menu > [Setup].

@® Click the [Change the closing data] tab.
® Enter the date that you want to set as the deadline date.
O Click [OK].
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Immediately acquiring the
log

The log can be acquired immediately
irrespective of the log acquisition schedule.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer, and then select the
[Printer] menu > [Acquire a Log].

Multiple printers can be selected.

@ Click [Close] in the acquisition results
window.

When the log is being displayed, select
the [Log] menu > [Refresh Display] to
refresh the log display.

Notifying the printer of the

time
As some printer models do not have a
built-in clock, the server software notifies
the printer of the time every hour when
the log is acquired. Therefore, when the
printer power is turned OFF/ON, the time
information cannot be logged until the
printer is notified of the time. In this case,
the time can be notified manually to the
printer.
The time notified to the printer is the
time in the computer in which the server
software is set up.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Select the printer, and then select the
[Printer] menu > [Setting the Time].

@ Click [OK] in the completed window.
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Changing the log save
location

The folder in which the acquired log is
saved and the folder to which the log is
automatically written can be specified.

© Start the server software.

® Select [Option] menu > [Setup].
® Click the [Login Storage] tab.

® Click [Browse].

@ Select the folder that you want to save,
and click [OK].

® Click [OK].

Displaying the Log

The log can be displayed according to
printer or date. One log is divided by each
category and displayed, so you can display
or delete logs according to requirements.
When printers are managed in groups, the
log can be displayed as a group.

Displaying the Log

@ Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

® Using the same operations as in step @,

open [Printer] and [Date] in the tree.
Displaying logs
by date

Displaying logs of all
printers belonging to
a group

Displaying individual
printer logs

Display logs by
printer group or by
individual printer
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O Select the log that you want to display,
and select the [Log] menu > [Display
Logs].

@ Displaying all logs for all printers

In the selection window, select [Log] >
[Printer] or [Log] > [Date] to display
the log.

@ Displaying all logs for specific printers

In the selection window, select [Log] >
[Printer] > [Printer Name] to display the
log.

@ Displaying all logs for a specific month

In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to display the log.
@ Displaying all logs for specific printers in a
specific month

In the selection window, select [Log] >
[Printer] > [Printer Name] > [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to display the log.

® Displaying all logs for a specific printer
group

In the selection window, select [Log] >
[Printer] > [Group Name] to display the
log.
® Displaying all logs for a specific printer
group in a specific month

In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) > [Group Name] to
display the log.

¢ Logs that are acquired while a log is
being displayed can be displayed by
selecting the [Log] menu > [Refresh
Display].
¢ At the top of the details window, the
date and printer name or group name
of the currently displayed log is shown.

e When the title section of each item is
clicked, the order is sorted (changed)
according to the item contents. When
clicked again, the items are sorted in
reverse order.

Date of the Printer name or group name
displayed log of the displayed log
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Displaying all log items
(detail display)

@ Start the server software.

@ Select the [Log] menu > [Display
Details], and check the [Log] check box.

If the log is being displayed, the display is

updated and all of the items are displayed.

Changing log items to be
displayed

@ Start the server software.

@® Select the [Log] menu > [Display/Export
Item Settings] > [Log Display Items].

® Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window log. You can
change the order by selecting an item,
and clicking [Up] or [Down].

O Click [OK].

When the log is displayed, the display is
updated.

(Note!) In the detailed display, all of the items
are displayed irrespective of these
settings.

- 195 -




9. Operating the Log

Deleting the Log

(Note!) e As one log is displayed in both the
printer and date trees, if a log is
deleted from a printer tree, the
corresponding section is also deleted

from the corresponding log in the date

tree.

¢ Deleted logs cannot be recovered.

@ Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

® Using the same operations as in step @,
open [Printer] and [Date] in the tree.

O Select the log that you want to delete,
and select the [Log] menu > [Delete the
log].

@ Click [Yes] in the confirmation window.

Outputting the Log as a
CSV file

Outputting as a CSV file

The acquired log can be output as a CSV
format file, and used in commercially
available spreadsheet software.

@ Start the server software.

@ Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

® Using the same operations as in step @,
open [Printer] and [Date] in the tree.

O Select the log that you want to export,
and select the [Log] menu > [Export
Logs].

@ Specify the folder and file name to be
saved, and click [Save].

Items within the exported items that
are not numbers are enclosed in ""
marks.
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Changing log items to be
exported

@ Start the server software.

@® Select the [Log] menu > [Display/Export
Item Settings] > [Log Export Items].

® Check the items you want to export, and
uncheck the items you do not want to
export.
The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or
[Down].

O Click [OK].

Automatically outputting the
Log as a CSV file

The acquired log can be automatically
output as a CSV file.

« A folder of the printer connection
destination (IP address or port name)
is created in the folder specified in
[log auto exporting folder] explained
in "Changing the log save location "
(page 193), and the log is exported to
a file named okrptXXXXYY.csv (where
XXXX is the year and YY the month)
within that folder.

e The items exported in the log can be
changed in "Changing log items to be
exported" (page 197).

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

O In the [Option] tab, change [Auto Export
Logs] to [Automatically export logs].

® Click [OK].
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Sending a mail to the log
administrator

Acquired logs can be automatically output
to CSV files, and the output file can be
sent as an e-mail attachment every month
to the administrator.

(Note!) The outgoing mail server, sender's
e-mail address and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).

e The mail is sent of the day after the

deadline (default setting is end of
the month) set in the "Changing the
deadline" (page 191).

e The items exported in the log can be
changed in "Changing log items to be
exported" (page 197).

@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ In the [Option] tab, change [Auto Export
Logs] to [Mail logs to administrator].

® Click [OK].

Exiting log acquisition

Log acquisition can be exited and
restarted.

@ Check that the printer power is ON.
@ Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Seclect the printer, and then select the
[Printer] menu > [Start/End Log].

Multiple printers can be selected.

@ Click [Yes] in the confirmation window.

® When the "Please enter the administrator
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password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Noteb Depending on the printer, this may not
be displayed.

(Note! When the following window is displayed,
a connection cannot be made to the
printer.

In this case, always click [No] and
connect to the printer before trying
again.
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Memo
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10.Aggregating logs

Acquired logs can be aggregated by printer, user ID, user name, or month. Also, aggregation
results can be exported as a CSV file.

Aggregating logs

Items that can be aggregated

Items that are displayed for aggregation are as shown below.

(Note!) The items that can be aggregated differ depending on the printer model or whether options

are used.
Item Details
Printer Name of the aggregating printer. This is displayed
when logs are aggregated by printer.
Address The connection destination of the aggregating printer.
This is displayed when logs are aggregated by printer.
Name Name of the aggregating user ID. This is displayed
when logs are aggregated by user ID.
Job Account ID This is the aggregating user ID. This is displayed
when logs are aggregated by user ID.
User Name of the aggregating user. This is displayed when
10 logs are aggregated by user name.
. Date Date of aggregation. This is displayed when logs are
aggregated by date.
Group The name of the group that the aggregating printer
or user belongs to.
Fees The total fees.
Jobs The total number of jobs.
Sheets The total number of sheets printed.
Pages The total number of pages printed.
Color The total number of color pages printed.
Mono The total number of monochrome pages printed.
Printer Use Time The total time the printer was used.
Completed ™ The total number of jobs that completed normally.
Canceled The total number of jobs cancelled by user operation.
(For printing, when one or more sheets are printed)
Aborted The total number of jobs cancelled by reasons other
than user operation.
Abnormal completed " The total number of jobs that completed abnormally.
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Item

Details

Detailed Status

e Log Buffer Full:
The total number of jobs cancelled because the
printer log is full.

e Access Control:
Total number of jobs cancelled due to use
restrictions.

e Memory Over Flow:
Total number of jobs cancelled due to memory
overflow.

e Color Control:
Total number of jobs cancelled due to use
restrictions (Disable Color Printing).

e Mono Printing (Color limited):
Total number of jobs printed in monochrome due to
use restrictions (Disable Color Printing).

e Lip Error: Total number of jobs cancelled due to lip
error.

A4~ Total print number for each paper size.

A5

A6

Simplex " The total number of sheets printed for simplex
printing.

Duplex The total number of sheets printed for duplex
printing.

Toner (C) Total number of pages for each level of used cyan
toner.

Toner (M) Total number of pages for each level of used magenta
toner.

Toner (Y) Total number of pages for each level of used yellow
toner.

Toner (K) Total number of pages for each level of used black
toner.

Drum (C) Total amount of use of cyan drum.

Drum (M) Total amount of use of magenta drum.

Drum (Y) Total amount of use of yellow drum.

Drum (K) Total amount of use of black drum and 4-in-one color
drum.

Belt Total amount of use of belt.

Fuser The total amount of belt and fuser used.

Staple When the optional finisher is installed, this shows the
number of times the stapler is used.

Plain =1+ Total print number for each paper type.

Letter Head
Transparency
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Item Details

Auto "2 Total print number for each paper thickness.
Light

Medium

Trayl = Total number of sheets supplied from tray 1.
Tray2 =12 Total number of sheets supplied from tray 2.
Tray3 12 Total number of sheets supplied from tray 3.
Tray4 "1+ Total number of sheets supplied from tray 4.
Tray5 1= Total number of sheets supplied from tray 5.

Multi-Purpose Tray "+

Total number of sheets supplied from the multi-
purpose tray/manual feeding tray.

Multi-Purpose Feeder "1+

Total number of sheets supplied from the optional
multi-purpose feeder.

300dpir -2 Total number of pages printed at 300dpi.
600dpi~t -2 Total number of pages printed at 600dpi.
600x1200dpi- Total number of pages printed at 600 x 1200 dpi.
1200dpi- = Total number of pages printed at 1200dpi.
2400x600dpir - Total number of pages printed at 2400 x 600 dpi.

Color Scan Page

The total number of scanned color pages.

Mono Scan Page

The total number of scanned monochrome pages.

Scan Job Print =

Total number of scan jobs that are accompanied with
printing.

Scan Job No Print =

Total number of scan jobs that are not accompanied
with printing.

PC Print =
Fax To Print =
PC Scan *

Total log number for each function.

Print =
Scan
Fax

Total log number for each service.

Communication Time *

Total time required to send or receive faxes.

Send

Total number of jobs sent by fax.

Receive

Total number of jobs received by fax.

Multi-cast Send

Total number of jobs sent by fax to multiple recipients.

Send on PC =

Total number of jobs sent by fax from a PC.

Multi-cast Send on PC =

Total number of jobs sent by fax to multiple
recipients from a PC.

Email Send

Total number of jobs sent by e-mail.

Multi-cast Email Send

Total number of jobs sent to multiple recipients by e-mail.

Communication page ™

Total number of pages sent and received by fax.

“If the aggregate result for this item is 0, it is not displayed.
“2This item is not displayed in the default settings.
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Displaying the aggregate @® Aggregating all logs for all printers

In the selection window, select [Log] >
@ Start the server software. [Printer] or [Log] > [Date] to
aggregate the logs.
@® Click the plus mark on the left side of 99red g
[Log] in the selected window. @ Aggregating all logs for specific
The log tree opens. printers

In the selection window, select [Log]
> [Printer] > [Printer Name] to
aggregate the logs.

® Aggregating all logs for a specific
month
In the selection window, select [Log] >
[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) to aggregate the
logs.
® Using the same operations as in step @,

open [Printer] and [Date] in the tree. @ Aggregating all logs for specific

printers in a specific month

In the selection window, select [Log] >
[Printer] > [Printer Name] [XXXX/YY]
(XXXX is the year, YY is the month), or
select [Log] > [Date] > [XXXX/YY] >
[Printer Name] to aggregate the log.

® Aggregating all logs for specific
groups
In the selection window, select [Log] >

[Printer] > [Group Name] to aggregate
the logs.

@ Select the logs to aggregate, and in the
[Log] menu > [Display Total], select [By
Printer], [By Job Account ID], [By User

Name], [By Month], [By Printer Group] or
[By User Group].
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® Aggregating all logs for specific Displaying all aggregated

groups in a specific month items (detail display)
In the selection window, select [Log] >

[Date] > [XXXX/YY] (XXXX is the year,
YY is the month) > [Group Name] to
aggregate the log. @® Select the [Log] menu > [Display
Details], and check the [Total] check box.

@ Start the server software.

—— If the aggregate is being displayed, the
@ @ display is updated and all of the items are
displayed.

e The dates and printer names of

the currently aggregated logs are

displayed at the top of the details
10 window.

e When the title section of each item is
clicked, the order is sorted (changed)
according to the item contents. When
clicked again, the items are sorted in
reverse order.

Dates of the Aggregated printer
aggregated logs names
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Changing aggregate items

@ Start the server software.

@® Sclect the [Log] menu > [Display/Export
Item Settings] > [Total Display Items].

® Check the items that you want to display,
and uncheck items you do not want to
display.
The display order is the same order as
that in the details window aggregate
items. You can change the order by
selecting an item, and clicking [Up] or
[Down].

O Click [OK].

When the aggregate is displayed, the
display is updated.

(Note!) In the detailed display, all of the items
are displayed irrespective of these
settings.

Outputting the
aggregation results as a
CSV file

Outputting as a CSV file

The aggregated results can be output as a
CSV format file, and used in commercially
available spreadsheet software.

@ Start the server software.

@® Click the plus mark on the left side of
[Log] in the selected window.
The log tree opens.

® Using the same operations as in step @,
open [Printer] and [Date] in the tree.

O Select the logs whose aggregates you
want to export, and in the [Log] menu
> [Export Total], select [By Printer], [By
Job Account ID], [By User Name], [By
Month], [By Printer Group] or [By User
Group].

@ Specify the folder and file name to be
saved, and click [Save].

Items within the exported items that
are not numbers are enclosed in ""

marks.
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Changing the log items to be
exported

@ Start the server software.

@® Select the [Log] menu > [Display/Export
Item Settings] > [Total Export Items].

® Check the items you want to export, and
uncheck the items you do not want to
export.
The items are exported in the displayed
order. You can change the order by
selecting an item, and clicking [Up] or
[Down].

O Click [OK].
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11.Client Software

This section explains the Job Accounting Mode set by the client software.

Changing Job Accounting
Mode

Job Accounting Mode is a method of setting
the user name and Job Account ID in the
Windows client computer. There are 4
modes.

(Note!) The Job Accounting Mode cannot be
changed in MacOS or Mac OS X.

Job Accounting Mode settings can only
be configured in a print driver that

supports Print Job Accouting.

Types of Job Accounting
Mode

Tab

The tab for setting the User Name and Job
Account ID to the print driver properties is
displayed.

It is used by the user themselves to set or
change the User Name and Job Account ID.

Popup

A pop-up window for setting the User Name and
Job Account ID to be sent for each print job is
displayed.

It is used when 1 computer is used by multiple
users.

(Note!) ¢ Do not select this when using the
Windows XP simple user switching
function.

e Even if printing is performed on the
shared printer client side, the input
window is not displayed. Use the hide
mode for shared printers.

e [Popup] cannot be selected for
Windows 7/Server 2008R2/Vista/
Server 2008.

Hide

Even if printing is performed on the shared
printer client side, the input window is not
displayed. Use the hide mode for shared printers.
The system administrator creates an ID file that
contains the Job Account ID and User Name that
correspond to the Windows login user in advance.
By specifying this file with the client software, the
user that performed the printing is identified, and
the corresponding Job Account ID is automatically
acquired. Furthermore, the same Job Account

ID can be set for all login users. The users do

not need to configure settings or to know their
own Job Account ID. When using the Windows
computer as a print server and the printer as a
shared printer, install and use the client software
onto the computer to be used as a print server.

Not supported

Users identification is not performed, and all
jobs are recognized as unregistered ID. The User
Name is the user name used to login to windows,
and the Job Account ID is 0. Used when user
recognition is not needed.

(Note!) When the printer drivers are updated
or reinstalled, the mode returns to
unsupported mode. Therefore, you need
to set the Job Accounting Mode again.
However, when using the function that
sets all printer drivers to the same
mode, it is not necessary to re-set the
mode settings.
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Using Tab Mode

@ Select [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].

When the [User Account Control] window
is displayed, click [Yes] or [No].

@® Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

® Select [Tab], and click [Change].

@ Click [OK] in the change notification
window.

@ Select [File] menu > [Close].

® In Windows 7/Server 2008 R2/Vista/
Server 2008, select [Start] > [Control
Panel], and click [Printer]. (For Windows
XP/Server 2003, select [Start] > [Printers
and FAX]. In Windows 2000, select
[Start] > [Settings] > [Printer]. )

@ On the printer driver icon, right-click the
mouse button and select [Properties].

® In the [Job Accounting] tab, enter the
User Name and Job Accounting ID, and
click [OK]. In the default settings, the
User Name is the user name used to login
to Windows, and the Job Account ID is 1.

© Print from the application.
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Using Popup Mode

@ Select [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode].

When the [User Account Control] window
is displayed, click [Yes] or [No].

@® Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

® Select [Popup], and click [Change].

@ Click [OK] in the change notification
window.

@ Select [File] menu > [Close].
® Print from the application.

@ When the popup window is displayed,
enter the User Name and Job Accounting
ID, and click [OK].

When [Cancel] is clicked, the user name
is blank and Job Account ID is 0 in the
log. The print job is not cancelled.
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Switching each user for a Job Account ID in hidden mode

@ Create an ID file using software such as Notepad or Excel etc.

<For Notepad>
@ The login user and Job Account ID are included for each user individually on a separate line.
The login user name and Job Account ID are separated with a comma (,).
Login user name:
User name entered when logging in to Windows
Job Account ID:
Job Account ID that corresponds to the login user name
User name:

User names used in Print Job Accouting
The user name can be omitted. When omitted, the login user name is used as the user name.

—O0O——

Login user
hame Job Account ID User name

® Save in text format with the extension "CSV".
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<For Excel>

@ The login user and Job Account ID are included for each user individually on a separate line.
® Save in CSV file format.

@® Select [Start] > [All Programs] ([Programs] in Windows 2000) > [Oki Data] > [Print Job
Accounting Client] > [Change Job Accounting Mode]. When the [User account management]
window is displayed, click [Continue] or [Yes].

® Select the printer driver of the printer that will acquire the log from the [Driver] list. To set

all printer drivers to the same mode, check the [Set the same mode for all drivers] check
box.

(Note!) When the shared printer is used, do not use the function that sets all printer drivers to the

same mode. When using a shared printer on the client side to print, the account information
is not output.
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@ Select [Hide], and click [Change].

I

@ Click [OK] in the change notification
window.

@® Select [Hide Mode] menu > [Import ID
File].

@ Specify the ID file created in @, and click
[Open].

® If [Hide Mode] menu > [Set the same
mode for all drivers] check box is
checked, uncheck it.

© Select [File] menu > [Close].

@ Print from the application.

(Note!) When printing is performed after
logging into Windows as a login user
that is not registered, the user name
is the current login user name, and the
Job Account ID is 0 in the log.

Select [Display registered Job Account
IDs] in the hide mode menu, and you

can authenticate Job Account IDs that
have already been registered, delete
unneeded Job Account IDs, and import
ID files.

Acquiring user information
from files in hide mode

User information can be acquired from a
specific file. The file created in "Exporting
data for client software" (page 126) can be
specified.

@ Select [Start] > [All Programs]
([Program] in Windows 2000) >
[Okidata] > [Print Job Accounting Client]
> [Change Job Accounting Mode]. When
the [User Account Control] window is
displayed, click [Continue] or [Yes].

@® Select the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

(Note!) When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

® Select [Hide], and click [Change].

J

@ Click [OK] in the change notification
window.
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@® Select [Hide Mode] menu > [Get user Using the same Job Account
information from a file]. ID for all users in hide mode

@ Select [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

@® Seclect the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for

® Check the [Get user information from a all drivers] check box.

file] check box, and click [Change].

(Note!) When the shared printer is used, do
not use the function that sets all printer
drivers to the same mode. When using
a shared printer on the client side to
print, the account information is not
output.

(: ® Select [Hide], and click [Change].

@ Select the file used to obtain the user

information, and click [OK].
11 ® Click [OK].

J

@ Click [OK] in the change notification
window.

® In the [Hide Mode] menu, check the [Set
the same mode for all drivers] check box.
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@® Select [Hide Mode] menu > [Setup Fixes
Job Account ID.

@ Enter the User Name and Job Account ID,
and click [OK].

memo | When the user name is omitted, the
login user name is used as the user
name.

® Select [File] menu > [Close].

© Print from the application.

Using in an unsupported
mode

@ Select [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accounting Client] >
[Change Job Accounting Mode]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

@® Sclect the printer driver of the printer
that will acquire the log from the [Driver]
list. To set all printer drivers to the same
mode, check the [Set the same mode for
all drivers] check box.

® Select [Not Supported], and click
[Change].

O Click [OK] in the change notification
window.

@ Select [File] menu > [Close].

@® Print from the application.
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Memo
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12. Operation and Management

12.0peration and Management

This section explains how to move the printer or change the server, and how to delete Print
Job Accouting.

Operation and Management

Setting the outgoing mail function

Configure the settings for using the mail send function. The outgoing mail server, outgoing
mail format, sender mail address and administrator mail address settings can be configured.

@ Start the server software.

@® Select [Option] menu > [Setup].
Configure the [Mail setup] tab settings.

)

@
®—

)

®
©—

@

©)

S

Enter the mail server (SMTP) used by the job account server. If you do not know the
server name, contact the network administrator.

Enter the port number. This is usually [25].
Check to perform user authentication when sending mail.
When user authentication is used, enter the login user name.

When user authentication is used, enter the password.

®© © ® © ©

Select the content to send.
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Message to be sent with
logs

This is the content of the mail sent using the function
to e-mail the log to the administrator.

Message to be sent when
the Limit Value was
exceeded

This is the content of the mail sent to the user or
user group when the limit value is exceeded.

Message to be sent when
printing is permitted

This is the content of the mail sent to the user or
user group when the limit value is reset and printing
can be performed.

Message to be sent with
total result

This is the content of the mail sent using the function
to notify the aggregate results by e-mail.

Message to be sent with
log acquisition status

This is the content of the mail sent using the function
to notify the log acquisition status by e-mail.

Message to be sent when
the size of attachment
files exceeded limit value

This is the content of the mail sent when the size of
1 attachment file exceeds the size set in the function
for limiting the size of attachment files.

Message to be sent when
failing in log preservation
to database

This is the content of the mail sent by the function
that notifies when the log fails to be saved to the
database. (Only Enterprise edition)

Message to be sent when
failing in transmitting
card table

This is the content of the mail sent by the function
that notifies when the IC card compatibility table
cannot be sent. (Only Enterprise edition)

Message to be sent when
the card information
doesn't exist in table

This is the content of the mail sent by the function
that notifies when there is no IC card information
in the IC card compatibility table. (Only Enterprise
edition)

Message to be sent when
the card information
overlaps in table

This is the content of the mail sent by the function
that notifies when the IC card information in the
IC card compatibility table is duplicated. (Only
Enterprise edition)

Message to be sent when
the number of users

in card table exceeded
maximum value

This is the content of the mail sent by the function
that notifies when the maximum number of
registered users in the IC card compatibility table is
exceeded. (Only Enterprise edition)

@ Enter the mail title.
Enter to include a header in the mail body.

©@ Enter to include a footer in the mail body.
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® Configure the mail address tab settings.

@ ®e 06

@ Enter the name of the mail sender.
® Enter the mail address of the mail sender.

®, @ Set the name and e-mail address of the person you want to send the log to using the
function to send log to the administrator. Enter the recipient's name in ® and email
address in @, and click [Add].
To send to multiple recipients, repeat this operation.

® Check that the recipient is displayed, and click [OK].
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Sending print prohibited/
permitted by mail

When [Notifies by e-mail when Limit Value
was exceeded] is checked, users are

notified by mail when the use limit value is
exceeded and printing cannot be executed.

Printing is now forbidden because the Limit Yalue was exceeded.

Frinter MCEE1(1592.168.0.2)

User  takahashi
Job Account ID 2

Also, users are notified by mail when the
limit value is reset and printing can be
executed.

Printing is now permitted because the usaze status was reset.
Printer MC3B1(192,168.0.2)

User  takahashi
Job Account ID 2

(Note!) The outgoing mail server and sender's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).

@ Start the server software.

@ Click the plus mark on the left side of
[Printer] in the selected window.
The printer tree opens.

® Select the printer or printer group that
you want to configure from the selection
window, and then select the [Printer]
menu > [Properties].

@ Click the [User] tab.
@ Select the user to set, and double-click it.

@® Check the [Notifies by e-mail when Limit
Value was exceeded] check box, and click
[OK].

(Note!) Users are not notified when the mail
address is not entered. Enter the mail
address.

To set multiple users, repeat steps @
and @.

@ Click [OK].

® In the [Registration of Job Account ID]
window, click [OK].

© In the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.
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Notifying the log acquisition
status by email

The administrator can be notified of the log
acquisition status by e-mail once a day.

HNotifies log acquizition status.

Printer MCIBE1 (192, 168.0.2)
Status Acquired

Last Acquizition Date 201009530 11:86:18

Printer CT11(182.168.0.3)

Status Acquired
Last Acquiszition Date 2010/09,/30) 11:28:439

(Note!) The outgoing mail server, sender's
e-mail address and administrator's
e-mail address need to be configured in
advance according to the "Setting the
outgoing mail function" (page 220).

@ Start the server software.

@® Select [Option] menu > [Setup].

® In the [Mail setup] tab, check the
[Notifies log acquisition status to
administrator by e-mail] check box.

O Click [OK].

Limiting the size and number
of attachments

The size and number of attachments can
be limited, and sent separately in different
e-mails.

@ Start the server software.
@® Select [Option] menu > [Setup].
® Click the [Mail detail setup] tab.

@ Check the [The size and the number of
attachment files are limited] check box,
and enter the [Limit size] and [Limit
number of files].

® Click [OK].

(Note!) When the limit size is exceeded for 1
file, a mail is sent notifying that the
attachment cannot be sent.
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Carrying over the unused
print limit quantity

When the [Carry over unused value to the
next valid period] check box is checked,
and the printer use limit value is not
exceeded, the unused amount can be
carried over to the next valid period.

In the example in the figure, if a user who
has a limit of 1,000 sheets per month only
prints 500 sheets, they can then print
1,500 sheets the following month.

/‘_“

Unused value

Limit value 500 sheets 1,500 sheets
1,000 sheets Printed value

500 sheets '

Current month Next month

@ Start the server software.

@ Click the plus mark on the left side of
[Printer] in the selected window.

The printer tree opens.

@ Select the printer/printer group to be set
in the selection window, and double-click
it.

@ Click the [User] tab.
@ Select the user to set, and double-click it.

@® Check [Carry over unused value to the
next valid period], and click [OK].

To set multiple users, repeat steps @
and @.

@ Click [OK].

® Click [OK] in the [Job Account ID
registration] window.

© In the [Properties of printer from which
logs are acquired] window, click [OK] to
close the printer properties.
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Deleting a registered printer @ Click [Yes] in the end log acquisition

. confirmation window.
To remove a printer from management by

Print Job Accouting because the printer (Note!) When the following window is displayed,

is to be moved or scrapped, delete the a connection cannot be made to the
printer from the server software before printer.
moving or scrapping it. In this case, always click [No] and
) ] connect to the printer before trying
@ Check that the printer power is ON. again.

@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

@ Select the printer that you want to
delete, and then select the [Printer]
menu > [Start/End Log].

Multiple printers can be selected.

@ Check that the printer [Status] field in
the details window is [Not acquired].

-
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® Select the printer you want to delete,
and select the [Printer] menu > [Delete a
Printer/Printer Group].

© Click [Yes] in the delete printer
confirmation window.

@ Specify the items to delete, and click
[OK].

® When the "Please enter the administrator
password of the printer" window is
displayed, enter the printer administrator
password, and click [OK].

(Note!) Depending on the printer, this may not
be displayed.

@® In the user ID delete confirmation
window, click [Yes] to delete the Job
Account ID from the registered printer, or
click [No] to keep the Job Account ID for
the registered printer.

® To delete the logs acquired until now by
the server software, click [Yes] in the log
delete confirmation window, or click [No]
to keep the logs in the server software.

Changing the printer
connection destination or IP
address

To change the printer connection
destination or IP address, change the
server software settings.

@ Check that the printer power is ON.
@® Start the server software.

@ Click the plus mark on the left side of
[Printer] in the selected window.

The printer tree opens.

@ Select the printer, and then select the
[Printer] menu > [Properties].

@ In the [Printer] tab, click [Change Address].

@® To change the connection destination,
select the connection destination from
the list and click [OK].

To change the IP address, enter a new IP
address, and click [OK].

@ In the [Properties of printer from which
logs are acquired] window, click [OK].
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Automatically reconnecting
when the printer IP address
is changed

When the printer IP address is changed,
the new IP address can be automatically
connected, and the log can still be
acquired. This is effective when the

IP address is dynamically assigned in
the DHCP environment, or when the
administrator changes the IP address.

@ Select [Option] menu > [Setup].
@® Click the [Ports] tab.

® Check the [Auto Reconnect] check box.

)

@ Enter the interval (unit: hours) at which
the IP change is checked.

® Click [OK].

Perform the following steps to change
the range in which a printer whose IP
address is changed is searched for.

@ Click [Scope].

® To add a search range, enter the
broadcast IP address of the search range
you want to add into [New Scope], and
click [Add].

® To delete a search range, select the
search range that you want to delete
from [Scope], and click [Delete].

@ To search the local subnet, check the
[Discover the local subnet] check box.

@ Click [OK].
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To change the server to a
different computer

To change the server that acquires the
current log to a different computer, delete
the printer on the current server, and then
re-add it to the new server.

If the current server cannot be used due
to a malfunction etc, perform the following
operations on the new server.

@ Check that the printer power is ON.

@® Start the server software on the new
server.

® Select the [Printer] menu > [Add a
Printer].

@ Follow the instructions on the screen to
add the printer.

® When the server ID input window is
displayed, enter the server ID of the
server that acquires the current log, and
click [OK].

@® Continue setup by following the
instructions on the screen.

Checking the server ID

@ Start the server software.

® Seclect [Help] menu > [Server ID].

® Check the server ID, and click [OK].
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Installing/Zuninstalling a
built-in hard disk or SD
memory card to the printer

@ See "Deleting a registered printer"
(page 226), and delete the printer
registered in the server software.

® A built-in hard disk or SD memory card
can be installed/uninstalled to the printer

® Add the printer again to the server
software.

Prohibiting initialization of the
built-in hard disk, SD memory
card, or flash memory

When the built-in hard disk, SD memory card,
or flash memory of the printer are initialized,
previous log obtained from the server
software is deleted. Also, as user information
is also deleted from the printer, the server
software cannot acquire the correct log. When
Print Job Accouting is used, it is necessary to
configure the settings so that the built-in hard
disk, SD memory card, and flash memory
cannot be initialized.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

O Select the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ In the [Option] tab, check the [Inhibit the
initialization of the Hard Disk and Flash
Memory] check box.

@® Click [OK].
The printer built-in hard disk, SD memory
card, and flash memory can no longer be
initialized.
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Operations when the log is
full

The processes when the printer log buffer
is full before the log is acquired by the
server software can be set.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the list view of the details
window.

@ Seclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.

@ In the [Option] tab, change [Operation at
Log Full].

Delete old logs

The oldest log is deleted, and the new log is
received.

Cancel the job

All subsequent print jobs are cancelled.

Do not acquire the log

The log is not obtained for subsequent print jobs.

® Click [OK].

Updating setting information
when an option is installed
(Only Enterprise edition)

When an option is added to a printer,
information can be acquired from the
printer, and the setting information
updated. When an SD card is installed
in the printer for receiving the IC card
compatibility table after the printer

is registered in the server software,

it is necessary to update the setting
information in the server software.

@ Check that the printer power is ON.
@® Start the server software.

® Double-click [Printer] in the selection
window. The registered printer list is
displayed in the details window.

@ Seclect the printer, and then select the
[Printer] menu > [Properties].

Multiple printers can be selected.
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@ Display the [Printer] tab, and click
[Acquire Information].

Changing the number of
printers connected at the
same time

The number of printers connected at the
same time can be changed. When the
number of printers connected at the same
time is set to a small value, the amount of
processing done by the computer for this
software is reduced.

@ Start the server software.

@ Click the [Option] menu > [Setup].

@® Click [OK]. To browse the updated setting ® Display the [Ports] tab.
information, repeat the steps from @ to
o O
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® Change [Number of printers connected at
the same time].

® Click [OK].

Uninstalling software

Uninstalling server software

When uninstalling the server software,
always delete the registered printers first
before uninstalling the server software.

@ See "Deleting a registered printer"
(page 226), and delete the printer
registered in the server software.

@ Exit the server software.

® Select [Start] > [All Programs]
([Programs] in Windows 2000) >
[Oki Data] > [Print Job Accouting] >
[Uninstall Print Job Accouting]. When the
[User account management] window is
displayed, click [Continue] or [Yes].

(Note!) When the following window is displayed,
the printer is not deleted. Always click
[No] to cancel the uninstallation, then
delete the printers before uninstalling
the server software.

@ Follow the instructions on the screen to
uninstall.

@ Click [Finish].
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Uninstalling the client
software (Windows)

@ If the client software is running, exit it.

@® Select [Start] > [All Programs]
([Programs] in Windows 2000) > [Oki
Data] > [Print Job Accounting Client] >
[Uninstall Print Job Accounting Client].
When the [User account management]
window is displayed, click [Continue] or
[Yes].

® Follow the instructions on the screen to
uninstall.

O Click [Finish].

Uninstalling plugins (MacOS)

When the printer drivers are uninstalled,
the plugins are also uninstalled.

Uninstalling client software
(Mac OS X)

Delete the Print Job Accouting icon that
was copied to the desired location during
installation.
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13.Troubleshooting

This chapter explains some of the problems that could possibly occur when using Print Job
Accouting, and provides hints to their solutions.

Item Details
Cannot find the printer e Check that the printer power is ON.
even when searching e Check whether the printer is processing or offline,
using [Add a Printer]. or whether an error has occurred (no paper etc).
Check that the printer is online, and click [Start new
search].

¢ Click [Back], and check that the correct search
option check boxes are checked.

e When the search target is [TCP/IP Network], check
whether the broadcast address is correct. If it is
unknown, contact the network administrator.

e The printer does not support Print Job Accouting.
Check the type of printer connected to the
connection destination.

o If the [Do not allow exceptions] check mark is
checked in the Windows XP SP2/Server 2003 SP1 or
later firewall settings, printers cannot be searched
beyond the router segments. Therefore, in the Add
log acquisition printer wizard, select [Specify the
printer by address], select [Address] > [TCP/IP
Network], and enter the IP address directly.

When a printer connection | The printer does not support Print Job Accouting.
destination is specified Check the type of printer connected to the connection
using [Add a Printer], the | destination.

error "Printer does not
have the log acquisition
capability" is displayed.

When adding a printer, There is not enough free space in the printer built-in
"There is no sufficient hard disk, SD memory card or flash memory.
capacity to store a log" Secure the appropriate amount of free space.

error is displayed.

When adding a printer e Check that the printer power is ON.

or changing settings, e Check whether the printer is processing or offline,
or when immediately or whether an error has occurred (no paper etc).
acquiring a log, the Check that the printer is online and try again.

"Cannot connect to the
printer. Wait for a while
and try again.", "Unable
to communicate with the
printer. Please check the
printer." or "The printer
is busy. Wait for a while
then try again" message
is displayed.
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Item

Details

When creating a CSV file
to register Job Account
IDs and Names in a
batch, "An error was
found in the import

file" error message is
displayed.

e Check whether the CSV file format is correct.

e Check that the names and Job Account IDs do not
exceed the registration range. The Job Account ID
is registered from 1 to 999999999, and the User
Names within 80 characters.

e Check that the " symbol is not included in names.
Names that include " cannot be registered.

When the ID file for
setting the hide mode
in the client software

is imported, "An error
was found in the import
file" error message is
displayed.

e Check whether the CSV file format is correct.

e Check that the User names and Job Account IDs do
not exceed the registration range. The Job Account
ID is registered from 1 to 999999999, and User
Name within 80 characters.

e Check that the " symbol is not included in user
names. Names that include " cannot be registered.

When printing, the print
job is automatically
cancelled and cannot be
executed.

e Check whether the Job Account ID of the print job is
"Disable Printing" or "Disable Color Printing".

e Check whether the limit value for the Job Account
ID is exceeded, and check the limit values and valid
period.

e The operation when log is full is set to "Cancel
the job", and the printer log buffer is full. Select
the printer, and then select the [Printer] menu >
[Acquire a Log] to acquire the log. Next, reset the
log acquisition schedule to a shorter time.

The log cannot be
acquired according to the
set schedule.

Select the printer, and then select the [Printer] menu
> [Acquire a Log]. When an error is displayed, check
that the printer power is ON. Also, check whether the
printer is processing or offline, or whether an error
has occurred (no paper etc).

When the log is acquired correctly, check the log
acquisition schedule. Check that the acquisition time
is at the same time as when the printer and server
power are usually ON. If there are no problems in the
above settings, restart Windows.

Not all of the logs are
acquired.

The printer's log buffer is full when the operation
for when the log is full is set to "Delete old logs" or
"Do not acquire the log", Reset the log acquisition
schedule to a shorter time.

Some logs are not
displayed at the start time
or end time.

If the printer model does not have a built-in clock,
when the printer power is switched OFF/ON, time
information cannot be stored in the log until the
printer is notified of the time. For details on how

to notify the printer of the time, see "Notifying the
printer of the time" (page 192).

For models that have a built-in clock, the time needs
to be set in the printer.
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Item

Details

When attempting to
delete a printer, "Cannot
delete while log is being
acquired" message is
displayed.

A printer cannot be deleted while the log is being
acquired. Select the printer that you want to delete,
select the [Printer] menu] > [Start/End Log] to end
acquiring the log, and then delete the printer.

When [Acquire a Log]

is performed, "Select

to start log before
attempting to acquire a
log" message is displayed.

The log is in the unacquired state. Select the printer
whose log you want to acquire, and select the
[Printer] menu > [Start/End Log] to start acquiring
the log. Logs can be acquired after starting.

When [Acquire a Log]
is performed, "This task
cannot be performed
while acquiring a log"
message is displayed.

The log is acquired according to the log acquisition
schedule.

Wait for a while to check whether the log is acquired.
If "Log acquisition schedule..." is shown for a long
time, restart Windows.

In the printer [Log] field
of the details window,
[Acquire from different
server] is displayed.

Either the log is set to be acquired by a different
server, or the printer flash memory was initialized.
Select the printer, and then select [Printer] menu >
[Delete a Printer/Printer Group] to delete the printer,
and then follow the steps in [Printer] menu > [Add a
Printer] to re-add the printer. If the printer is set to
acquire the log from a different server, see "To change
the server to a different computer" (page 229).

Cannot perform menu
printing or demo printing
from the control panel of
the printer.

e Check whether the local printer is set to printing
prohibited or color printing prohibited.

e Check the limit values and valid period to ensure
that the local print limit values are not exceeded.

Cannot initialize the flash
memory from the printer
control panel. Also, the
hard disk or SD memory
card cannot be initialized
for models equipped with
an internal hard disk or
SD memory card.

When using the Print Job Accouting, check the [Inhibit
the initialization of the Hard Disk and Flash Memory]
check box in the server software. In this state, the
flash memory, built-in hard disk and SD memory card
cannot be initialized. Follow "Deleting a registered
printer" (page 226) to delete the printer, and then
initialize the flash memory, built-in hard disk or SD
memory card. After initializing, select the [Printer]
menu > [Add a Printer], and follow the steps to re-
add the printer.
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